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WARRANTY

Tektronix warrants that the products that it manufactures and sells will be free from defects in materials and

workmanship for a period of one (1) year from the date of shipment. If this product proves defective during its

warranty period, Tektronix, at its option, will either repair the defective product without charge for parts and labor,

or provide a replacement in exchange for the defective product.

This warranty applies only to products returned to the designated Tektronix depot or the Tektronix authorized

representative from which the product was originally purchased. For products returned to other locations,

Customer will be assessed an applicable service charge. The preceding limitation shall not apply within the

European Economic Area, where products may be returned for warranty service to the nearest designated service

depot regardless of the place of purchase.

In order to obtain service under this warranty, Customer must provide the applicable office of Tektronix or its

authorized representative with notice of the defect before the expiration of the warranty period and make suitable

arrangements for the performance of service. Customer shall be responsible for packaging and shipping the

defective product to the service center designated by Tektronix or its representative, with shipping charges

prepaid. Tektronix or its representative shall pay for the return of the product to Customer. Customer shall be

responsible for paying any associated taxes or duties.

This warranty shall not apply to any defect, failure or damage caused by improper use or improper or inadequate

maintenance and care. Tektronix shall not be obligated to furnish service under this warranty:

a) to repair damage resulting from attempts by personnel other than Tektronix representatives to install, repair or

service the product;

b) to repair damage resulting from improper use or connection to incompatible equipment;

c) to repair any damage or malfunction caused by the use of non-Tektronix supplies or consumables;

d) to repair a product that has been modified or integrated with other products when the effect of such

modification or integration increases the time or difficulty of servicing the product; or

e) to repair damage or malfunction resulting from failure to perform user maintenance and cleaning at the

frequency and as prescribed in the user manual (if applicable).

THE ABOVEWARRANTIES ARE GIVEN BY TEKTRONIX WITH RESPECT TO THIS PRODUCT IN LIEU OF

ANY OTHERWARRANTIES, EXPRESS OR IMPLIED. TEKTRONIX AND ITS VENDORS DISCLAIM ANY

IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. TEKTRONIX’

RESPONSIBILITY TO REPAIR OR REPLACE DEFECTIVE PRODUCTS IS THE SOLE AND EXCLUSIVE

REMEDY PROVIDED TO THE CUSTOMER FOR BREACH OF THIS WARRANTY. TEKTRONIX AND ITS

VENDORSWILL NOT BE LIABLE FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL

DAMAGES IRRESPECTIVE OFWHETHER TEKTRONIX OR THE VENDOR HAS ADVANCE NOTICE OF THE

POSSIBILITY OF SUCH DAMAGES.
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General Safety Summary

Review the following safety precautions to avoid injury and prevent damage to
this product or any products connected to it. To avoid potential hazards, use this
product only as specified.

Only qualified personnel should perform service procedures.

Use Proper Power Cord. Use only the power cord specified for this product and
certified for the country of use.

Ground the Product. This product is grounded through the grounding conductor
of the power cord. To avoid electric shock, the grounding conductor must be
connected to earth ground. Before making connections to the input or output
terminals of the product, ensure that the product is properly grounded.

Observe All Terminal Ratings. To avoid fire or shock hazard, observe all ratings
and markings on the product. Consult the product manual for further ratings
information before making connections to the product.

The common terminal is at ground potential. Do not connect the common
terminal to elevated voltages.

Do not apply a potential to any terminal, including the common terminal, that
exceeds the maximum rating of that terminal.

Do Not Operate Without Covers. Do not operate this product with covers or panels
removed.

Avoid Exposed Circuitry. Do not touch exposed connections and components
when power is present.

Do Not Operate With Suspected Failures. If you suspect there is damage to this
product, have it inspected by qualified service personnel.

Do Not Operate in Wet/Damp Conditions.

Do Not Operate in an Explosive Atmosphere.

Keep Product Surfaces Clean and Dry.

Provide Proper Ventilation. Refer to the manual’s installation instructions for
details on installing the product so it has proper ventilation.

To Avoid Fire or
Personal Injury
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Terms in this Manual. These terms may appear in this manual:

WARNING. Warning statements identify conditions or practices that could result

in injury or loss of life.

CAUTION. Caution statements identify conditions or practices that could result in

damage to this product or other property.

Terms on the Product. These terms may appear on the product:

DANGER indicates an injury hazard immediately accessible as you read the
marking.

WARNING indicates an injury hazard not immediately accessible as you read the
marking.

CAUTION indicates a hazard to property including the product.

Symbols on the Product. The following symbols may appear on the product:

Protective Ground

(Earth) Terminal

CAUTION

Refer to Manual

Double

Insulated

WARNING

High Voltage

Symbols and Terms
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Preface

This is the user manual (volume 1) for the DTG5000 Series Data Timing Genera-
tor. It covers the following information:

� Describes the capabilities of the data timing generator, how to install it and
reinstall its software.

� Provides tutorials to familiarize the user with two basic operation modes.
The pulse generator mode and data generator mode.

� Lists standard and optional accessories and instrument options available for
the data timing generator.

About This Manual

This manual is composed of the following sections:

� The Getting Started shows you how to configure and install your data timing
generator and provides instrument options and accessories list.

� The Operating Basics describes the data timing generator instrument
controls including rear panel connectors. It also provides information on the
data timing generator screen elements.

� The Data Structure describes the concept of data timing generator pattern
data.

� The Tutorials provides simplified application examples, which show you
how to create/edit the pattern data.
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Related Manuals and Online Documents

This manual is part of a document set of standard-accessory manuals and online
documentation. This manual mainly focuses on installation, background, and
user information needed to use the product features. See the following list for
other documents supporting the data timing generator operation and service.
(Manual part numbers are listed in Accessories & Options on page 1--17.)

Document name Description

DTG5000 Series Online Help An online help system, integrated with the User Interface application that ships with this
product. The help is preinstalled in the data timing generator.

DTG5000 Series User Manual, volume 2 A reference provides encyclopedia of topics that describe the data timing generator
interface and features, and gives background information on how to use them.

DTG5000 Series Programmer Manual Provides complete information on programming commands and remote control of the
instrument.

DTG5000 Series Technical Reference for
Performance Verification & Specifications

Describes how to verify the performance of the data timing generator and lists its
specifications.

DTG5000 Series Service Manual Describes how to service the data timing generator to the module level. This optional
manual must be ordered separately.
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Contacting Tektronix

Phone 1-800-833-9200*

Address Tektronix, Inc.
Department or name (if known)
14200 SW Karl Braun Drive
P.O. Box 500
Beaverton, OR 97077
USA

Web site www.tektronix.com

Sales support 1-800-833-9200, select option 1*

Service support 1-800-833-9200, select option 2*

Technical support Email: techsupport@tektronix.com

1-800-833-9200, select option 3*

6:00 a.m. -- 5:00 p.m. Pacific time

* This phone number is toll free in North America. After office hours, please leave a
voice mail message.
Outside North America, contact a Tektronix sales office or distributor; see the
Tektronix web site for a list of offices.
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Product Description

This section describes the DTG5000 Series Data Timing Generators and their
options. Following this description are two subsections:

� Installation shows you how to configure and install the data timing
generator, as well as how to reinstall the system software included with the
product.

� Accessories & Options lists the standard and optional accessories for this
product.

Models

This manual supports the following data timing generators:

� DTG5078 Data Timing Generator

� DTG5274 Data Timing Generator

The differences between the data timing generators will be called out when
necessary; otherwise, the material applies to all data timing generators. The word
“data timing generator” refers to both products.

Key Features

The DTG5000 Series Data Timing Generator is a high speed/multichannel signal
generator which creates a wide range of digital timing signals. The products are
designed to generate a data pattern for standard and nonstandard pulses necessary
for functional tests or characterization of legacy devices (TTL, CMOS, ECL) as
well as the latest devices (PECL, LVDS, GTL, CML).

The DTG5000 Series Data Timing Generator supports three types of output
modules (DTGM10, DTGM20, and DTGM30). Table 1--1 lists the key features
of the data timing generators.
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Table 1--1: DTG5000 series key features

DTG5078 DTG5274

Maximum clock
frequency/ Maxi-
mum data rate

750 MHz/750 Mb/s 2.7GHz /2.7 Gb/s

Number of slot 8 (A, B, C, D, E, F, G, and H) 4 (A, B, C, and D)

Pattern length 240 to 8,000,000 words/channel 960 to 32,000,000 words/channel

Block size
granularity

1 1 to 4 (depends on Vector Rate)

Sequence steps 1 to 8,000 steps 1 to 8,000 steps

Sequence
repeat counter

1 to 65,536 or Infinite 1 to 65,536 or Infinite

Data Generator
Mode

Slot A, B, C, D, E, F, G, and H Slot A, B, C, and D

Data format Slot A to D NRZ, RZ, and R1 Slot A to D NRZ, RZ, and R1

Slot E to H NRZ

, ,

Data rate NRZ 50 kb/s to 750 Mb/s NRZ 50 kb/s to 2.7 Gb/s

RZ and R1 50 kb/s to 375 Mb/s RZ and R1 50 kb/s to 1.35 Gb/s

Channel addition Slot A, B, C, and D Slot A, B, C, and D

Jitter generation Channel 1 of slot A Channel 1 of slot A

Lead delay
resolution

1 ps 0.2 ps

Trail delay
resolution

5 ps 5 ps

Pulse width
resolution

5 ps (slot A, B, C, and D) 5 ps (slot A, B, C, and D)

Pulse Generator
Mode

Slot A, B, C, and D Slot A, B, C, and D

Clock frequency 50 kHz to 375 MHz 50 kHz to 1.35 GHz

Output Module DTGM10 DTGM20 DTGM30 DTGM10 DTGM20 DTGM30

Number of
channel

4 4 2 2 of 4
(CH1, CH2)

2 of 4
(CH1, CH2)

2

Amplitude (50 Ω) 3.5 Vp-p 3.5 Vp-p 1.25 Vp-p 3.5 Vp-p 3.5 Vp-p 1.25 Vp-p

Amplitude
(1 MΩ)

10 Vp-p 7 Vp-p 2.5 Vp-p 10 Vp-p 7 Vp-p 2.5 Vp-p

Rise time/fall
time at 1 Vp-p
into 50 Ω
(20% to 80%)

<540 ps
(variable)

<340 ps
(variable)

<110 ps <540 ps
(variable)

<340 ps
(variable)

<110 ps

Master-Slave Up to three (one Master, two Slaves) Up to two (one Master, one Slave)
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Mainframe and Output Module Configuration

The DTG5000 Series Data Timing Generator offers card modular system. Three
types of the output modules can be combined in any combination. Each module
can be inserted into any slot. The functional restrictions are:

� 8 (eight) slots installed in the DTG5078 (A, B, C, D, E, F, G, and H)

� 4 (four) slots installed in the DTG5274 (A, B, C, and D)

� When the DTGM10 or DTGM20 is installed to the DTG5274, CH3 and
CH4 are not available. Only CH1 and CH2 can be used.

� Slot E, F, G, and H are not available in the Pulse Generator mode.

� Available data formats are different:

� NRZ, RZ, R1 (Slot A, B, C, and D)

� NRZ (Slot E, F, G, and H)

Product Software

The data timing generator includes the following software:

� The system software, which includes a specially configured version of
Windows 2000, comes preinstalled on the data timing generator. Win-
dows 2000 is the operating system on which the user-interface application of
this product runs, and provides an open desktop for you to install other
compatible applications.

NOTE. Do not attempt to substitute any version of Windows that is not specifi-

cally provided by Tektronix for use with this instrument.

� The DTG5000 Software comes preinstalled on the data timing generator.
This software, runs on Windows 2000, is the data timing generator applica-
tion. This software starts automatically when the data timing generator is
powered on, and provides the user interface (UI) and all other instrument
control functions. You can also minimize the data timing generator applica-
tion.

� The product software runs not only on the data timing generator
mainframe, but also on the general PC. When the software runs on the
data timing generator mainframe, it is called the Online mode.While
running on the PC, it is called the Offline mode. In the Offline mode, it
is possible to create and edit the pattern data and set the output parame-
ters.
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� The DTG5000 Configuration Utility comes preinstalled on the data timing
generator. This software, running on Windows 2000, is used for setting up
the system configurations for the DTG5000 Software. This software controls
the Master operation, Master/Slave operation, Online/Offline operation, and
so forth.

NOTE. When you use the DTG5000 software with the offline mode, you must also

install the DTG5000 Configuration Utility into your PC.

� The Readme file contains release notes and updates that could not be
included in other product documentation.

� There are no limits on number of PCs that can operate in the offline mode.

Occasionally new versions of software for your instrument may become
available at our web site. See Contacting Tektronix on page ix in the Preface
section for web site information.

Software Upgrade

Tektronix may offer software upgrade kits for the data timing generator. Contact
your Tektronix service representative for more information (see Contacting
Tektronix on page ix).



DTG5078 & DTG5274 Data Timing Generator User Manual 1--5

Installation

This section covers installation of the data timing generator, addressing the
following topics:

� Unpacking on page 1--5

� Checking the Environment Requirements on page 1--6

� Output Module on page 1--7

� Connecting to a Network on page 1--8

� Connecting Peripherals on page 1--9

� Powering On the Data Timing Generator on page 1--10

� Setting up Windows 2000 on page 1--11

� Shutting Down the Data Timing Generator on page 1--12

� Creating an Emergency Rescue Disk on page 1--14

� Backing Up User Files on page 1--16

� Installing Software on page 1--16

CAUTION. Be sure to create your emergency rescue disk as described on

page 1--14. You may need that disk if you ever need to reinstall Windows 2000

from the data timing generator hard drive.

Unpacking

Verify that you have received all of the parts of your data timing generator. The
packing list shows the standard accessories that you should find in the shipping
carton. The output modules are not shipped within the mainframe carton. You
should also verify that you have:

� The correct power cord for your geographical area

� Two compact discs that include copies of the software installed on the data
timing generator and additional support software that may be useful to you.
Store the product software in a safe location where you can easily retrieve it.

� Recovery disk for Windows (R) 2000 Professional
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� DTG5000 Series Product Software

NOTE. The certificate of authenticity (Windows 2000 licence agreement) is

attached to your data timing generator. This certificate proves your ownership of

the Windows operating system in your mainframe. Without this certificate, you

might have to purchase a new Windows license if the hard disk in your main-

frame ever needs rebuilding or replacement.

� All the standard and optional accessories that you ordered

� Output module(s) you ordered

Remember to fill out and send in the customer registration card. The registration
card is packaged with this manual.

Checking the Environment Requirements

Read this section before attempting any installation procedures. This section
describes site considerations and power requirements for your data timing
generator.

The data timing generator is designed to operate on a bench in the normal
position (on the bottom feet). For proper cooling, at least three inches (7.62 cm)
of clearance is required on both sides of the data timing generator, and the
bottom requires the clearance provided by the mainframe feet.

If you operate the data timing generator in the Master-Slave mode, you can stack
up to two mainframes.

CAUTION. To avoid damage to the mainframe, always close the bottom stands

when you stack the mainframes.

Using a cart is not recommended when you stack the mainframes. Doing so

could result in serious damage to the cart or mainframes.

Do not operate the mainframe while it rests on its left side feet. Always place the

mainframe in the normal position (on the bottom feet) while the mainframe

powered-on.

Site Considerations
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Table 1--2 shows general operating requirements for the data timing generator.
For more information, refer to Technical Reference for Performance Verification
& Specifications. It covers power source, temperature, humidity and altitude
information.

Table 1--2: Operating requirements

Item Description

Operating temperature +10�C to +40�C

Operating relative humidity 20% to 80% (No condensation)

Operating altitude Up to 3 km (10,000 ft)

Power supply

Rating voltage 100 V to 240 V

Voltage range 90 V to 250 V

Frequency 47 Hz to 63 Hz

Maximum power 600 VA maximum

Output Module

The DTG5000 Series Data Timing Generator mainframe and output module(s)
are shipped separately. At least one output module must be installed in the
mainframe slot to operate properly.

Three types of output modules can be combined in any combination. Each
module can be inserted in any slot. There are functional differences between slot
A to D and slot E to H. (Refer to Mainframe and Output Configuration on page
1--3.) It is recommended that slot A should be used when only one output
module is installed in the mainframe slot.

To install the output module, first power off the mainframe using the front panel
On/Standby switch.

Operating Requirements

Installing the Output
Module
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CAUTION. To prevent damage to the output module or mainframe, never install

or remove the output module when the mainframe is powered on.

Avoid touching the board surface or connectors of the output module with your

fingers when you handle the module.

Attach the blank panel to the mainframe module slot(s) when the output

module(s) are not installed.

If the output module is not in use for a long time, attach the connector caps and

SMA terminations (DTGM30) to the output module and then store the output

module in the shipping carton. The connector caps and SMA terminations are
provided with your output module.

1. Verify that the data timing generator mainframe is not powered on.

2. Remove the blank panel from the mainframe slot.

3. Place the output module in a compartment.

4. Gently push the output module into the slot with firm pressure.

5. Once the module is seated, tighten the two screws to secure the module to
the mainframe.

Verify that the data timing generator mainframe is not powered on.

1. Loosen the two screws.

2. Grasp the right and left screws and slowly pull the module out of the
mainframe slot.

3. Attach a blank panel to the slot.

Connecting to a Network

You can connect the data timing generator to a network to enable printing, file
sharing, internet access, and other communications functions. In the Master-
Slave mode, the slave mainframe is controlled by the Master-mainframe
connection between the mainframes. Before you use the Master-Slave mode,
connect each mainframe to a network. Refer to page 2--9 for more information
explaining Master-Slave connections. Also see Figure 2--3:Rear panel connec-
tions.

Connect the network cable to the mainframes before power-on.

For more information on the Master-Slave operation, refer to DTG5000 Series
User Manual, volume 2.

Removing the Output
Module
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Connecting Peripherals

The peripheral connections are the same as those you would make on a personal
computer. The connection points are shown in Figure 1--1. See Table 1--3 for
additional connection information.

CAUTION. To avoid product damage, power off the data timing generator or

place the data timing generator in Standby power mode before installing any

accessories except a USB mouse or a USB keyboard to the mainframe connec-

tors. (You can connect or disconnect USB devices while powering on the

mainframe.) See Powering Off the Data Timing Generator on page 1--12.

CD-ROM drive MouseCOM

LAN VGA monitor

USB GPIB Keyboard

Figure 1--1: Locations of peripheral connectors on rear panel

Table 1--3: Additional connection information

Item Description

Monitor If you use an external monitor with the data timing generator
mainframe screen, the resolution of the external monitor is
fixed to 800 x 600. If you select the external monitor only, high
resolution display can be possible. You can set the resolution
by using the Windows 2000 control panel.

Printer If you connect the printer directly to the data timing generator,
connect the USB printer to a USB connector port of the
mainframe. You cannot connect the parallel printer directly to
the mainframe. If your data timing generator is connected to
LAN, you can use a network printer.
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Powering On the Data Timing Generator

Follow these steps to power on the data timing generator. Refer to page 1--11 for
Windows 2000 setup.

1. Connect the proper power cord from the rear panel power connector to the
power system.

Switch

AC power
connector

Figure 1--2: Principal power switch and AC power connector

NOTE. Connect the keyboard, mouse and other accessories before applying

power to the product.

2. Turn on the principal power switch at the rear panel. (See Figure 1--2 for
switch location.)

3. Push the front panel On/Standby switch to power on the data timing
generator (see Figure 1--3 for the switch location).

On/Standby
Switch

Figure 1--3: On/Standby switch location
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Setting up Windows 2000

You need to set up the Windows 2000 when you first power on the data timing
generator.

NOTE. Connect the keyboard and mouse before powering on the mainframe when

you set up the Windows 2000.

1. Attach the standard accessory USB mouse and USB keyboard to the data
timing generator mainframe. Three USB connector ports are equipped with
the mainframe (two on the rear panel and one on the front right side).

2. Push the front panel On/Standby switch to power on the mainframe.

3. The Windows 2000 setup wizard appears on the data timing generator
screen.

4. Follow the on-screen instructions.

5. When Your Product Key dialog box appears, enter the bar code number
which is located at the rear panel of mainframe.

6. Click Next button to display Date and Time Settings dialog box.

7. Confirm that the Date and Time Settings information is correct, and the click
Next button.

8. A dialog box pops up to let you know that the Windows 2000 setup has been
completed.

9. Click Restart Now, and Windows runs.

The computer name is DTG5000, and you can log on the Windows 2000 as the
following user name and password.

� User name: Administrator

� Password: dtg5000

If you want to add the user name, or want to change the password, always use
the Control Panel --> Users and Passwords. For more information, consult
Windows 2000 Help.

NOTE. If you connect a second or third DTG5000 Series Data Timing Generator

to the network, use different computer names for additional mainframes.
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Shutting Down the Data Timing Generator

When you push the front-panel On/Standby switch, the data timing generator
starts a shutdown process (including a Windows shutdown) to preserve settings.
This action removes power from most circuitry in the data timing generator.
Avoid using the rear panel power switch or disconnecting the line cord to power
off the mainframe.

The DTG5000 Series Data Timing Generator runs on Windows 2000, the shut
down process is similar to a PC.

There are three ways to shut down the mainframe:

� Push the On/Standby switch

� Select the Windows Start menu, and then select Shut Down...

� Select the File menu from the DTG5000 software, then select Shutdown.

When the data timing generator settings were not changed.When the
DTG5000 software is not running, or if the data timing generator settings have
not changed since the mainframe start-up, the shut down process closes all the
programs on Windows then restores the settings. The power is automatically shut
off.

When the data timing generator settings were changed. If the DTG5000 Series
Data Timing Generator settings were changed after the mainframe start-up. The
dialog box shown below appears on the screen and asks if you want to save the
current settings. Push any button within five seconds.

� Select Yes to specify the file name and location, and then select OK to
continue the shut down process.

� Select No without saving the setup file and continue the shut down process.

� Select Cancel to abort shut down process and to return to the DTG5000 soft-
ware.
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If you do not select the options within five seconds, Windows forces to terminate
the DTG5000 software. The End Program dialog appears.

� Select End Now to continue the shut down process without saving the setup
file.

Without any action in ten seconds, the following dialog box appears.

The DTG5000 software is waiting for the information about whether the user
wants to save the setup information. In this case, Windows cannot terminate the
DTG5000 software.

� Select End Now to continue the shut down process without saving the setup
file.

� Select Cancel to return to the DTG5000 software.

In all cases, select End Now to exit all the Windows programs while preserving
the current Windows setting. This shuts off the power to the mainframe.

To completely remove the power from the data timing generator, perform the
shutdown described above. Shut off the principal power switch at the rear panel,
and then disconnect the power cord from the mainframe.
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NOTE. If you push the front panel On/Standby switch for more than four seconds,

the data timing generator power is forced to be shut off.

Do not attempt to push the rear panel principal power switch before shutting

down the mainframe properly.

Creating an Emergency Rescue Disk

Now that you have completed the basic installation process, you should create an
emergency rescue disk that you can use to restart your data timing generator in
case of a major hardware or software failure.

NOTE. Create the emergency rescue disk and store it in a safe place. It may allow

you to recover your Windows 2000 installation without rebuilding the entire data

timing generator hard disk.

The emergency rescue disk contains basic files to restart your data timing
generator. Follow these steps to create the emergency rescue disk:

1. Log on the mainframe with the administrator name. Refer to page 1--11.

2. Click the Windows Start button, select Program --> Accessories --> System
Tools --> Backup. The following dialog box appears.

3. Insert a formatted floppy disk into the floppy disk drive, and then click
Emergency Repair Disk.
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4. The Emergency Repair Diskette dialog box appears.

5. Click Also backup the registry..., and then click OK.

6. Wait until the task completes. The following dialog appears.

7. Click OK, then remove the floppy disk and store it at a safe place.
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Backing Up User Files

You should always back up your user files on a regular basis. Use the Back Up
tool to back up files stored on the hard disk. The Back Up tool is located in the
System Tools folder in the Accessories folder.

1. Log on the mainframe with the administrator name. Refer to page 1--11.

2. Click the Windows Start button, select Program --> Accessories --> System
Tools --> Backup.

3. Click Backup Wizard.

4. Follow the on-screen instructions.

5. The backup tool allows you to select your backup media and to select the
files and folders that you want to back up. Use the Windows online help for
information on using the Backup tool. You can back up to the floppy drive or
to a third-party storage device.

Installing Software

The data timing generator mainframe ships with the product software installed,
so only perform the reinstallation if it becomes necessary. For more information
on the software reinstallation, refer to the User Manual, volume 2.

In case of instrument problems, you may wish to run the system diagnostics. See
the related manual (Technical Reference for Performance Verification and
Specifications) for more information on self tests and system diagnostics.

System Diagnostics
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Accessories & Options

This section lists the standard and optional accessories available for the
DTG5000 Series Data Timing Generator as well as the product options.

Options

The following instrument options can be ordered for the instrument.

Table 1--4: Instrument options

Option Description

Mainframe (DTG5078/DTG5274)

Option D1 Certificate with Calibration Data

Option 1R Rackmount kit

Output Module (DTGM10/DTGM20/DTGM30)

Option D1 Certificate with Calibration Data

The following power cord options are available for the instrument.

Table 1--5: Power cord options

Option Area Tektronix part number

A0 North America 161-0230--01

A1 Universal European 161-0104--06

A2 United Kingdom 161-0104--07

A3 Australian 161-0104--05

A5 Switzerland 161-0167--00

A6 Japan 161-A005--00

A10 China 161-0306--00

A99 No power cord ------

Power Cord Options
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The following two language options are provided for the data timing generator
documents. You must specify a language option when you place an order.

Table 1--6: Language options

Option Descriptions Part number

L0 English manuals

User Manual, volume 1 071-1281--xx

User Manual, volume 2 071-1282--xx

Programmer Manual 071-1283--xx

Technical Reference for Performance
Verification and Specifications

071-1280--xx

L5 Japanese manuals

User Manual, volume 1 071-1277--xx

User Manual, volume 2 071-1278--xx

Programmer Manual 071-1279--xx

Technical Reference for Performance
Verification and Specifications 1

071-1280--xx

1 This manual is provided in English only.

Language Options
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Accessories

This section lists the standard and optional accessories available for this data
timing generator.

The following accessories are shipped with the data timing generator:

Table 1--7: Standard accessories

Accessory Part number

Mainframe

User Manual, volume 1

User Manual, volume 2 See Table 1--6 for
Programmer Manual

See Table 1 6 for
part number.

Technical Reference for Performance Verification and Specifications

Windows  2000 Professional Operating System Recovery Disk 062-A300-xx

DTG5000 series Product Software 062-A301-xx

USB Keyboard 119-B146-00

USB Mouse 119-B145-00

Lead Set for DC Output 16-CON twisted pair, 60 cm (24 in) 012-A229-00

Front Cover 200-4651-00

Accessory Pouch 016-1441-00

50 Ω SMA Termination, Male, DC-18 GHz 015-1022-01

Ten SMA Connector Caps (DTG5078) 200-A531-00

Eight SMA Connector Caps (DTG5274) 200-A531-00

Output Module

Installation Manual 071-1284-xx

Notice Sheet 061-4261-xx

Four SMA Connector Caps (DTGM10 or DTGM20) 200-A531-00

Two SMA Connector Caps (DTGM30) 200-A531-00

Two 50 Ω SMA Terminations, Male, DC-18 GHz (DTGM30) 015-0706-00

Standard
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The accessories in Table 1--8 can be ordered for use with the data timing
generator at the time this manual was originally published. Consult a current
Tektronix catalog for additions, changes, and details.

Table 1--8: Optional accessories

Accessory Part number

Service Manual 071-1285-xx

50 Ω SMA Cable set for 2 units Master-Slave Operation 012-A230-00

Four 51 cm SMA Cables (174-1427-00)

Two 46 cm BNC Cables (012-0076-00)

50 Ω SMA Cable set for 3 units Master-Slave Operation 012-A231-00

Six 51 cm SMA Cables (174-1427-00)

Three 46 cm BNC Cables (012-0076-00)

Transition Time Converter, 150 ps 015-0710-00

Transition Time Converter, 250 ps 015-0711-00

Transition Time Converter, 500 ps 015-0712-00

Transition Time Converter, 1000 ps 015-0713-00

Transition Time Converter, 2000 ps 015-0714-00

HDMI TPA-R Test Adapter set 013-A012-50

Two HDMI TPA-R TDR

HDMI TPA-R DI (differential)

HDMI TPA-R SE (single end)

HDMI TPA-P Test Adapter set 013-A013-50

HDMI TPA-P TDR

HDMI TPA-P DI (differential)

HDMI TPA-P SE (single end)

DVI TPA-R Test Adapter set 013-A014-50

Two DVI TPA-R TDR

DVI TPA-R DI (differential)

DVI TPA-R SE (single end)

GPIB cable (2 m, double-shielded) 012-0991-00

GPIB cable (1 m, double-shielded) 012-0991-01

Pin Header Cable (51 cm, 20 in) 012-1505-00

Pin Header SMB Cable (51 cm, 20 in) 012-1503-00

SMB-BNC Adapter 015-0671-00

50 Ω BNC Cable (46 cm, 18 in) 012-0076-00

50 Ω BNC Cable (61 cm, 24 in) 012-1342-00

Optional
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Table 1--8: Optional accessories (cont.)

Accessory Part number

50 Ω BNC Cable (107 cm, 42 in) 012-0057-01

50 Ω BNC Cable (250 cm, 98 in) 012-1256-00

50 Ω SMA Cable (30 cm, 12 in) 174-1364-00

50 Ω SMA Cable (51 cm, 20 in) 174-1427-00

50 Ω SMA Cable (100 cm, 39 in) 174-1341-00

50 Ω SMA Cable (152 cm, 60 in) 174-1428-00

50 Ω Delay SMA Cable (1 ns, Male to Female) 015-1019-00

50 Ω Delay SMA Cable (2 ns, Male to Male) 015-0560-00

50 Ω Delay SMA Cable (2 ns, Male to Female) 015-1005-00

50 Ω Delay SMA Cable (5 ns, Male to Male) 015-0561-00

50 Ω Delay SMA Cable (5 ns, Male to Female) 015-1006-00

50 Ω SMA Male to BNC Female Adapter 015-0554-00

50 Ω SMA Female to BNC Male Adapter 015-0572-00

50 Ω SMA Male to N Male Adapter 015-0369-00

50 Ω SMA Male to SMA Female Adapter 015-0549-00

50 Ω SMA Female to SMA Slide On Male Adapter 015-0553-00

50 Ω SMA Male to SMA T (Female/Female) Connector 015-1016-00

50 Ω SMA Divider (Ma/Ma/Ma, 6 dB, DC to 18 GHz, VSWR: 1.9) 015-1014-00

50 Ω BNC DC Block (500 kHz to 2 GHz) 015-0221-00
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Operating Basics

This section contains information on the various interfaces for controlling the
DTG5000 Series Data Timing Generator and basic menu operation of the
instrument.

� The Front Panel Controls on page 2--1 provides a quick overview of front
panel controls such as the knob, buttons and keys.

� The Front Panel Connectors on page 2--5 subsection provides a quick
overview of front panel connectors.

� The Rear Panel Connectors on page 2--7 provides a quick overview of rear
panel connectors.

� The Display Area and Application Windows on page 2--10 describes the
overview of screen elements and the application windows.

� The Using the Menu System on page 2--37 provides an overview of the menu
and key operations of the data timing generator.

Front Panel Controls

This section introduces you to the front panel controls of the data timing
generator, which provides a brief overview on how to use the front panel key
controls.

In addition to the front panel controls, you can also control the data timing
generator from a keyboard and a mouse (provided with the instrument).

The MENU and SELECT buttons, TAB, ESC, and the Up, Down, Left and
Right arrow keys are called navigation keys. These buttons and keys allow you
to perform the data timing generator basic windows operation without using a
mouse or a keyboard. Figures 2--1 shows the locations of the front-panel
controls.

MENU button. Pushing theMENU button opens the pull-down menu items of the
last menu bar that you opened, regardless of current selection.

To cancel the pull-down menu, push theMENU button again. Pressing the ESC
key also forces the pull-down menu to disappear, however the menu bar is still
active. If you press any arrow key in this state, the key operates on the menu bar
area. Pressing the ESC key twice moves the focus to the lower window area.

Navigation Keys
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SELECT button. The SELECT button has the same capability as the Windows
standard ENTER key. This button is mainly used for the following actions:

� Use to make a selection on the pull-down menu items

� Use to open a pop-up menu in a tabular view

� Use to select an item in a pop-up menu

� Use to select OK or Cancel in the dialog box

Navigation
keys

Digit Select
arrow keys

Figure 2--1: Front panel controls

TAB key. The TAB key is used to move the focus within the window. By pressing
the SHIFT and TAB keys simultaneously, you can move the focus in the reverse
direction.

ESC key. The ESC key is used to cancel text input or dialog box appearance. To
cancel the menu items opened with theMENU button, press the ESC key twice.

Arrow keys (Up, Down, Left and Right). The arrow keys are used for the following
actions:

� Use to open the pull-down menus on the menu bar and move to the desired
items, after pushing theMENU button (you can also use the knob).

� Use to move the current cell (cursor position) in a tabular view
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� Use to select a radio button

The arrow keys have the capability of auto repeat.

DATA, LEVEL and TIMING buttons. Provide direct access to frequently used menus.

� DATA button: The DATA button is used to display previously selected pattern
data editing window (Data-Listing window or Data-Waveform window).
While one window is displayed, pushing this button switches to the alternate
window on the screen.

� LEVEL button: The LEVEL button is used to display the Level window and
moves the focus to the previously selected items.

� TIMING button: The TIMING button is used to display the Timing window
and moves the focus to the Clock Frequency or previously selected item.

Knob. The knob is used to increment or decrement a set value or select an item
from a pop-up or pull-down menu. Use right or left arrow keys just under the
knob to move the digit when you increment or decrement the setup value.

Digit Select arrow keys. The Digit Select arrow key is used to move the underbar
to a field that contains an editable number. This will allow you to change the
digit with the knob.

RUN button. The RUN button is used to control the start and stop of signal
outputs.

If the signal is being output, the LED indicator lights up. To actually output the
signal through the output connectors, you must turn the Output on in the Level
window or push the front panel ALL OUTPUTS ON/OFF button.

PULSE GEN button. The PULSE GEN button is used to toggle between Pulse
Generator and Data Generator modes. The LED lights up when the instrument is
in PG mode.

MANUAL TRIGGER button. The MANUAL TRIGGER button is used to generate
an internal trigger.

MANUAL EVENT button. The MANUAL EVENT button is used to generate an
event signal internally.

Suffix buttons (p, G/n, M/�, k/m). After you complete the input with numeric keys,
you can determine the unit by pushing one of the suffix buttons, without pressing
the Enter key.

If you push a suffix button for a frequency, the unit is interpreted as G (giga-), M
(mega-) or k (kilo-). If you push it for a time or voltage, the unit is interpreted as
p (pico-), n (nano-), � (micro-) or m (milli-).

SHIFT key. The SHIFT key has the same capability as the Shift key on a
Windows PC keyboard.
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ALT key. The ALT key has the same capability as the Alt key on a Windows PC
keyboard.

CTRL key. The CTRL key has the same capability as the Ctrl key on a Windows
PC keyboard.

ALPHA key. The ALPHA key is used to enter a character with a numeric key.
Pressing the ALPHA key causes the LED to light up.

While the LED is on, the data timing generator is in the text input mode and you
can use numeric keys to enter alphanumeric characters.

SPACE key. The SPACE key switches the On/Off state of a check box. Pressing
the ALT and SPACE keys simultaneously displays the Control menu. See DTG
icons on page 2--11 for details on the Control menu.

BKSP key. The BKSP key has the same capability as the Back Space key on a
Windows PC keyboard.

DEL key. The DEL key has the same capability as the Delete key on a Windows
PC keyboard.

ALL OUTPUTS ON/OFF button. This button is used to switch the on/off of channel
output, DC output or clock output. To turn on or off of these outputs, use the
Level window, DC Output window, or Time Base window, respectively. You can
turn on or off the channel (or DC or clock) outputs all together by using this
button, instead of switching the on/off separately.

If you push this button while at least one active channel or DC output or clock
output is on, all the outputs turn off.

If you push this button while all the outputs are off, all the outputs turn on.

In the Data Generator mode, the physical channels that are not assigned to logic
channel do not turn on.
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Front Panel Connectors

Figure 2--2 shows the locations of the data timing generator front panel
connectors.

SKEW CAL IN

DC OUTPUT

USB

TRIGGER IN

EVENT IN

SYNC OUT

Figure 2--2: Front panel connectors

CAUTION. To prevent damage to your data timing generator, do not apply a

voltage outside the specified input voltage range.

Do not apply a voltage to the output connector.

External trigger signal input connector.

Input Voltage Range.

� --5 V to +5 V, 50 Ω

� --10 V to 10 V, 1 kΩ

� Connector: BNC

TRIGGER IN
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Event signal input connector.

Input Voltage Range.

� --5 V to +5 V, 50 Ω

� --10 V to 10 V, 1 kΩ

� Connector: BNC

Synchronized signal output connector for CML level.

Data Generator Mode. A pulse is output at the head of each block of the output
pattern. If the block repeats, the pulse is output at each repeated block head.

Pulse Generator Mode. Single pulse is output at the timing of Burst. No signal is
output in Continuous operation.

� VOH = 0 V, VOL = --0.4 V into 50 Ω to GND

� Connector: SMA

Signal input connector for adjusting channel-to-channel skews.

Input Voltage Level.

� ECL into 50 Ω to --2 V

� Connector: SMA

Outputs eight channel DC voltage. This signal is independent of the output
module signal.

Output Voltage Range.

� -- 3.0 V to 5.0 V

� Connector: 2.54 mm 2 x 8 pin header (female)

Connect a USB device.

EVENT IN

SYNC OUT

SKEW CAL IN

DC OUTPUT

USB
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Rear Panel Connectors

Figure 2--3 shows the locations of the data timing generator rear panel connec-
tors. Also refer to Figure 1--1 on page 1--9 for peripheral connectors and ports.

Figure 2--3: Rear panel connectors

CAUTION. To prevent damage to your data timing generator, do not apply a

voltage outside the specified input voltage range.

Do not apply a voltage to the output connector.

The CD-ROM drive is used to reinstall the DTG5000 product software or to
rebuild the operating system.

COM port.

Connect a PS/2 mouse. Any USB mouse must be connected to the USB port.

CD-ROM drive

COM

Mouse
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Connect a PS/2 keyboard. By connecting a keyboard and mouse to the connec-
tors, you can perform the Windows PC operations more easily. Any USB
keyboard must be connected to the USB port.

The GPIB port. Used to control the data timing generator through the GPIB.

Connect a USB device. The keyboard and mouse of the data timing generator
standard accessories must be connected to the USB port.

If an external display is connected to this connector, the same image as the data
timing generator LCD screen is displayed on it.

Resolution Settings.

� The 800 by 600 setting is recommended.

� It is possible to set the data timing generator display off (from the Control
Panel settings) and to display the screen image with external display. In this
condition, images can be displayed at a higher resolution. If the external
display is disconnected from the connector, images are displayed on the data
timing generator screen at a resolution of 800 by 600 pixels, regardless of the
resolution settings of the external display.

LAN is a port used to connect the data timing generator to a network. Connect a
10Base-T or 100BASE-T connector here. In the Master-Slave operation, the
Master mainframe controls the Slave machine by way of network.

The following external clock input/output signal connectors are equipped.

EXTERNAL IN. Connect the external clock input signal.

� Input Voltage Range: 0.4 Vp-p to 2 Vp-p into 50 Ω

� Input Frequency Range:
DTG5078: 1 MHz to 750 MHz
DTG5274: 1 MHz to 2.7 GHz

OUT, OUT. Outputs the clock signal. Amplitude and Offset can be set in the Time
Base window.

� Output Voltage Range VOH: --1.00 V to 2.47 V into 50 Ω to GND

� Output Voltage Range VOL: --2.00 V to 2.44 V into 50 Ω to GND

� Output Voltage Amplitude: 0.03 Vp-p to 1.25 Vp-p

� Resolution: 10 mV

Keyboard

GPIB

USB (2 ea)

VGA

LAN

CLOCK
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� Signal type: Complementary

� Connector: SMA

NOTE. A 50Ω SMA termination is provided with your data timing generator

mainframe. When you use the instrument with single end, attach the termination

to the unused connector.

Clock, Jump and Timing signals used for Master-Slave operation.

CLK IN, CLK IN. Clock signal input connector to receive the clock signal from the
master-mainframe.

� Voltage level: ECL

� Connector: SMA

CLK OUT1, CLK OUT2, CLK OUT3, CLK OUT1, CLK OUT2, CLK OUT3. Outputs the
clock signals from the master-mainframe to control the clock of slave-main-
frame. Connect the CLK OUT1 to CLK IN of master-mainframe. CLK OUT3
and CLK OUT3 are equipped only in DTG5078.

� Connector: SMA

JUMP IN. Signal input connector to control the sequence waveform outputs in
Master-Slave operation. Connect the master-mainframe JUMP OUTx signal to
the slave-mainframe JUMP IN.

� Connector: BNC

JUMP OUT1, JUMP OUT2, JUMP OUT3. Signal output connectors to control the
sequence waveform outputs in Master-Slave operation. This signal is used to
control sequence waveform jumps of slave-mainframe. Connect the JUMP
OUT1 to JUMP IN of master-mainframe. JUMP OUT3 is equipped only in
DTG5078.

� Connector: BNC

External PLL input/output signal connectors.

PHASE LOCK IN. External PLL input signal connector.

� Input Voltage Range: 0.2 Vp-p to 3.0 Vp-p

� Input Frequency Range: 1 MHz to 200 MHz

� Impedance: 50 Ω, AC coupled

� Connector: BNC

Master-Slave Connection

PHASE LOCK



Operating Basics

2--10 DTG5078 & DTG5274 Data Timing Generator User Manual

EXTERNAL 10 MHz REF IN. External 10 MHz reference clock input signal
connector.

� Input Voltage Range: 0.2 Vp-p to 3.0 Vp-p

� Input Frequency Range: 10 MHz¦ 0.1 MHz

� Impedance: 50 Ω, AC coupled

� Connector: BNC

10 MHz REF OUT. Outputs 10 MHz reference clock signal.

� Output Voltage Amplitude:
1.2 Vp-p into 50 Ω to GND
2.4 Vp-p into 1 MΩ to GND

� Impedance: 50 Ω, AC coupled

� Connector: BNC

Display Area and Application Windows

Menu Bar: Access to data timing
generator functions and online

help system here.

Status Bar: Display of operating
status, mode, clock frequency,

and online status on/off.

Toolbar: Switches window
display, quick access to
various windows here.

Figure 2--4: Screen elements just after the power on
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You can access each of the menu bar items by using theMENU button and the
Up, Down, Left and/or Right arrow keys.

DTG icons (control box menus). These menus control the data timing generator
window operations.

Table 2--1: Control box menus

Items Description

Resize Restores the window to the initial display size.

Move Moves the window. You can use the Up, Down, Left and/or Right
arrow key to move the window in the direction. Press the Enter key
for completion.

Size Resizes the window. First, press the Up, Down, Left or Right arrow
key to enable one of the window sides. Pressing another pair of
arrow keys enables the window corner. Press the Enter key for
completion.

Minimize Minimizes the window.

Maximize Maximizes the window.

Close (Alt + F4) Closes current window.

File Menu. The File menu controls the data timing generator file operations.

Table 2--2: File menus

Items Description

Default Setup Restores the data timing generator settings to the defaults.

Open Setup... Opens the saved settings file.

Save Setup Saves current settings, overwriting the old ones.

Save Setup As... Saves current settings in a new file under a name you specify.

Import... Imports a file created with another application. (Data-Listing and
Data-Waveform window)

Exit Exits the DTG5000 software.

Shutdown Exits all the applications including the DTG5000 software and shuts
down Windows, then powers off the DTG5000 series mainframe.
This menu cannot be selected in the offline mode.

Menu Bar
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Edit Menu. The Edit menu shows various pull-down menus depending on the
active window or the items specified by cursor. Refer to each window descrip-
tion.

View Menu. The View menu controls the data timing generator display.

Table 2--3: View menus

Items Description

View by Channel Displays data for channel by channel. (Data-Listing, Data-Waveform,
Level, and Timing window)

View by Group Displays data for group by group. (Data-Listing, Data-Waveform,
Level, and Timing window)

Zoom In Doubles the size of the view horizontally, with the cursor position as
the base. (Data-Waveform window)

Zoom Out Halves the size of the view horizontally, with the cursor position as
the base. (Data-Waveform window)

View with Timing When the data timing generator displays the data pattern, the Timing
window setup information such as Format, Delay, Pulse Width and
Polarity are included. (Data-Waveform window)

Move Up Moves current-selected line upwards one line. (Timing and Level
window)

Moves current group position upwards one line. (Data-Waveform
window)

Move Down Moves current-selected line down one line. (Timing and Level
window)

Moves current group position down one line. (Data-Waveform
window)

Move Left Moves current group position left by one. (Data-Listing window)

Move Right Moves current group position right by one. (Data-Listing window)

Reset Order Arranges the channels within the current group according to their
numbers. (Timing and Level window)

This command has no influence on viewing in the Data-Listing or
Data-Waveform window.

Properties... Specifies the display format such as Radix, Signs, Magnification
display. (Data-Listing and Data-Waveform window)

Specifies how data is listed when viewed by group.

Toolbar Hides or displays the toolbar.
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Settings Menu. The Settings menu allows the selection of setup windows.

Table 2--4: Settings menus

Items Description

Channel Group Displays the Channel Group window which creates/edits groups and
assigns logic and physical channels.

Blocks Displays the Blocks window which creates and edits blocks.

Data-Listing Displays the Data-Listing window which creates and edits patterns.

Data-Waveform Displays the Data-Waveform window which creates and edits
patterns.

Level Displays the Level window which sets the output level.

Timing Displays the Timing window which sets the clock frequency, delay,
long delay on/off.

Time Base Displays the Time Base window which specifies the clock source,
trigger source, and event signals.

Sequence Displays the Sequence window which creates sequence. It also sets
the jump mode and jump timing.

Subsequence Displays the Subsequence window which creates subsequence.

Jitter Generation Displays the Jitter Generation window which sets the jitter generation
parameters.

DC Output Displays the DC Output window which sets the DC Output
parameter.

System Menu. The System menu contains the items related to the data timing
generator system.

Table 2--5: System menus

Items Description

Run Starts the signal output. This is the same as pushing the RUN button
on the front panel.

Stop Stops the signal output. This is the same as pushing the RUN button
on the front panel during the signal output is being performed.

Data Generator Switches to Data Generator mode. This has the same effect as
pushing the front panel PULSE GEN button or clicking Data Gen/
Pulse Gen button on status bar.

Pulse Generator Switches to Pulse Generator mode. This has the same effect as
pushing the front panel PULSE GEN button or clicking Data Gen/
Pulse Gen button of status bar.

Remote Control... Makes the settings for remote control through GPIB.
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Table 2--5: System menus (cont.)

Items Description

Diagnostics... Executes the internal hardware check.

LCD Panel Check... Executes the LCD operation check.

Front Panel Key
Check...

Verifies if the front panel controls are operational. Pressing a key or
knob on the front panel to display its name and change the color of
the key or knob on the screen. Pressing ENTER key twice to exit the
front panel key check.

Skew Calibration... Executes the skew calibration.

Level Calibration... Executes the level calibration.

Service Password... Displays the password input dialog box. This menu is provided for
service engineer.

Options Menu. The Options menu contains the Preference item that is used for the
instrument setup.

Table 2--6: Options menu

Items Description

Preference... Startup: You can select a startup state for either default settings or
the most recent settings you used.

LCD Brightness: Adjusts the brightness of the display screen of the
data timing generator.

Help Menu. The Help menu contains help topics and password input box.

Table 2--7: Help menus

Items Description

Help Topics... Opens the DTG5000 series online help screen.

Help on Window... Opens the help screen for currently displayed window.

Specifications... Displays the DTG5000 series specifications.

Contacting Tektronix... Displays the contact information for product support.

About DTG... Displays the instrument software version and copyright information.

Toolbar. The toolbar contains the shortcut buttons for the data timing generator.
Accessing the toolbar requires a mouse. Two types of toolbars are provided; the
common toolbar to all windows and a specific toolbar for several windows. See
Figure 2--5.
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To hide or display the toolbar on the screen, select Toolbar from the View menu.

Click to open DC Output window

Click to open Jitter Generation window

Click to open Subsequence window

Click to open Sequence window

Click to open Time Base window

Click to open Timing window

Click to open Level window

Click to open Data-Waveform window

Click to open Data-Listing window

Click to open Channel Group window

Click to open Blocks window

Common toolbar

High/Low setting (Level window only)

Amplitude/Offset setting (Level window only)

Click to display pattern data by group

Click to display pattern data by channel

Level window or Timing window

Data-Listing or Data-Waveform window

Click to open Properties dialog

Click to open Move Cursor To dialog

Click to open Copy to Clipboard dialog

Click to paste the copied item from the clipboard

Click to display pattern data by group

Click to display pattern data by channel

Click to zoom in the display (Data-Waveform window only)

Click to zoom out the display (Data-Waveform window only)

View with Timing (Data-Waveform window only)

Figure 2--5: Toolbar
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Status Bar. The status bar provides useful information about the state of the data
timing generator operation or setup.

Operating mode button

User clock frequency

Run status animation

Run status

Clock output

Online/Offline

Figure 2--6: Status bar

Table 2--8: Status Bar

Items Description

Operating mode button Displays the operating mode (Data Generator mode or Pulse
Generator mode). Click to toggle DG and PG modes.

User Clock frequency Displays the user clock frequency and period set by Timing window.
User clock frequency = H/W clock frequency / Vector rate

Run status animation Displays the sequencer status with animated screen.

Run status Displays the seqeuncer status.

Clock Output Displays the on/off of clock output.

Online/Offline Displays the DTG5000 software execution mode.
Appears only in the offline mode.
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The Channel Group window enables you to group the logical channels and
associate the logical channels with physical channels. The physical channels
represent the hardware channels which are actually installed in the data timing
generator. See Figure 2--7.

Figure 2--7: Channel Group window

� Group List. This list shows the logical channels comprising each of the
groups and the physical channels associated with the logical channels. By
default, the list shows the installed hardware channels (online mode) or
logical channels set by the DTG5000 Configuration Utility (offline mode).
The channels are grouped by eight channels.

� Channels. This list shows the actual installed channels (online mode) or
physical channels set by the DTG5000 Configuration Utility (offline mode).

Edit menu. This menu contains group editing and channel assignment commands.

Table 2--9: Edit menus for Channel Group window

Items Description

New Group... Creates a new group.

Delete Group Deletes the group you selected.

Delete All Group Deletes all the groups.

Rename/
Resize Group...

Renames the group you selected.
Changes the number of channels included in the group.

Channel Group Window
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Table 2--9: Edit menus for Channel Group window (cont.)

Items Description

Auto Assign Assigns physical channels installed in the data timing generator to
the logical channels in order.

De-assign All Clears all the logical and physical channels assignments.

De-assign Clears the physical channels assigned to the logical channels you
selected.

Preset

8 Channels per Group Defines the number of channels per group as 8.

1 Channel per Group Defines the number of channels per group as 1.

All Channels in One
Group

Collects all the channels in a single group.

The basic data pattern is called “block” in the Data Generator mode. In the
Blocks window, you can create a new block, rename it, and resize or delete the
block.

Figure 2--8: Blocks window

Blocks Window
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Table 2--10 shows the setup items in the Blocks window.

Table 2--10: Setup items for Blocks window

Items Description

Block Name Specifies the block name.
Accepts up to 32 characters and 8,000 blocks.

Block Size Specifies the block size.
Up to 32,000,000 (DTG5274) or up to 8,000,000 (DTG5078).

Edit Menu. This menu contains commands that are used to delete blocks or move
them to the edit windows.

Table 2--11: Edit menus for Blocks window

Items Description

Edit Sets Block Name or Block Size.

View Listing Views the content of the selected block in the Data-Listing window,
where you can edit its content.

View Waveform Views the content of the selected block in the Data-Waveform
window, where you can edit its content.

Delete Deletes the block on the selected line.
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In this window, a list of blocks is displayed in tabular form that can be edited.
The content edited in the Data-Listing window is the same as that of Data-Wave-
form window. The only difference is their display format. The Data-Listing
window displays the data as tabular form, while the Data-Waveform window
displays the data graphically. Because the data to be edited is identical, the edited
data in either of the windows is automatically reflected in the other.

Figure 2--9: Data-Listing window

A table which indicates the blocks, a cursor, and a marker which specifies the
edit range are displayed in the window.

The table is displayed by channel or by group. In the group mode, you can select
one of various Radix display formats.

There are two methods to edit a pattern. Directly enter the numeric value to each
cell or use the Edit menu.

Sometimes the editing requires specifying the edit range. You can specify all of
the current channels and groups, the channels and groups between markers, or
the area you specified with cursor.

Data-Listing Window
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Edit Menu. This menu contains commands that create or edit various data
patterns, move the cursor or marker, switch between the channel and group
views, and sort the channels and groups listed.

Table 2--12: Edit menus for Data-Listing window

Items Description

Undo Reverses the previous change to the data.

Move Cursor To... Moves cursor.

Move Marker To... Moves Marker 1 or Marker 2.

Copy... Copies the data to the data timing generator clipboard.

Paste Pastes the data copied in the data timing generator clipboard on the
location starting from the active cursor cell.

Invert... Inverts the data between 0 and 1 in the specified range.

Mirror... Mirrors the data in the specified range in the vector or bitwise
direction.

Shift/Rotate... Moves the data in the specified range in the bitwise direction. Shift
fills the empty cells with 0s. Rotate fills them with the offscreen data.

Fill with One/Zero... Fills the specified range with 0s or 1s.

Clock Pattern... Fills the specified range with a clock pattern of 0s and 1s.

Predefined Pattern... Fills the specified range with a Binary Counter, Johnson Counter,
Graycode Counter, Walking Ones, Walking Zeros or Checker Board
pattern.

User Defined Pattern Fills the specified range with a pattern the user entered.

PRBS/PRWS... Fills the specified range with a pseudo random pattern.

Select Block... Select another block to be viewed or edited.

Copy to Clipboard... Copies the data in the specified range as characters to the Windows
clipboard.

Paste from Clipboard... Pastes the data copied in the Windows clipboard as characters to
the location starting from the active cursor cell. Also available for
importing data from other applications.
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In this window, the blocks are displayed graphically and they can be edited. The
content edited in the Data-Waveform window is the same as that of Data-Listing
window. The only difference is their display format. The Data-Listing window
displays the data as tabular form, while the Data-Waveform window displays the
data graphically. Because the data to be edited is identical, the edited data in
either of the windows is automatically reflected in the other.

Figure 2--10: Data-Waveform window

Edit Menu. This menu contains the same commands as the Data-Listing window.

Table 2--13: Edit menus for Data-Waveform window

Items Description

Undo Reverses the previous change to the data.

Move Cursor To... Moves cursor.

Move Marker To... Moves Marker 1 or Marker 2.

Copy... Copies the data to the data timing generator clipboard.

Paste Pastes the data copied in the data timing generator clipboard on the
location starting from the active cursor cell.

Invert... Inverts the data between 0 and 1 in the specified range.

Mirror... Mirrors the data in the specified range in the vector or bitwise
direction.

Shift/Rotate... Moves the data in the specified range in the bitwise direction. Shift
fills the empty cells with 0s. Rotate fills them with the offscreen data.

Data-Waveform Window
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Table 2--13: Edit menus for Data-Waveform window (cont.)

Items Description

Fill with One/Zero... Fills the specified range with 0s or 1s.

Clock Pattern... Fills the specified range with a clock pattern of 0s and 1s.

Predefined Pattern... Fills the specified range with a Binary Counter, Johnson Counter,
Graycode Counter, Walking Ones, Walking Zeros or Checker Board
pattern.

User Defined Pattern Fills the specified range with a pattern the user entered.

PRBS/PRWS... Fills the specified range with a pseudo random pattern.

Zoom In Doubles the size of the view horizontally, with the cursor position as
the base.

Zoom Out Halves the size of the view horizontally, with the cursor position as
the base.

Move Up Moves the current group position up one line. Available only when
the table is viewed by group.

Move Down Moves the current group position down one line. Available only when
the table is viewed by group.

Reset Order Arranges the channels within the current group according to their
numbers. Available only when the table is viewed by channel. Has
no influence on viewing in the Waveform window.

Properties... Specifies how data is listed when viewed by group (Magnitude).

Select Block... Select another block to be viewed or edited.

Copy to Clipboard... Copies the data in the specified range as text to the Windows
clipboard.

Paste from Clipboard... Pastes the data copied in the Windows clipboard as text to the
location starting from the active cursor cell. Also available for
importing data from another application.
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In this window, you can set the High/Low levels and the termination voltage or
impedance for logic channel. It also allows you to turn the output to on or off.
The level of output signal can be specified by combining the High/Low levels or
Amplitude/Offset values.

Figure 2--11: Level window

The Level window allows you to setup the items for each channel. See Table
2--14.

Table 2--14: Setup items for Level window

Items Description

High Sets the High level value.

Low Sets the Low level value.

H Limit Sets the High level limit value.

L Limit Sets the Low level limit value.

Limit Turns on or off the High/Low limit feature.

Term R Sets the termination impedance of the destination of the output
signal.

Term V Sets the termination voltage of the destination of the output signal.

Output Turns the output to on or off.

Level Window
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Edit Menu. The Edit menu of the Level window allows you to set the items
below. You can turn on or off Limit and Output, or you can specify Open to
Termination Impedance (Term.R), depending on the selection. The table 2--15
lists the common setting items regardless of the selection:

Table 2--15: Edit menus for Level window

Items Description

Predefined Level... Provides the following levels:

TTL (into open), TTL (into 50 Ω to GND),
CMOS 5 V (into open), CMOS 3.3 V (into open),
ECL (into 50 Ω to --2 V),
PECL (into 50 Ω to 3 V), PECL (into 50 Ω to 5 V),
LVPECL (into 50 Ω to 1.3 V), LVPECL (into 50 Ω to 3.3 V),
LVDS (into 100 Ω differential), TMDS (into 50 Ω to 3.3 V),
RSL (into 28 Ω to 1.8 V), CML (into 50 Ω to GND)

High/Low Specifies High and Low for the level setting.

Amplitude/Offset Specifies Amplitude and Offset for the level setting.

Apply to Channels in the
Same group

Applies the currently selected settings to all channels within the
group.

Apply to All Channels Applies the currently selected settings to all channels.
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In this window you can set the pattern format and time base parameters such as
the frequency, delay, pulse width and slew rate. Some of the settings parameters
are different in Data Generator mode and Pulse Generator mode.

Figure 2--12: Timing window (Data Generator mode)

Table 2--16: Setup items for Timing window

Items Description

Clock Frequency Sets the clock frequency of the data timing generator system. Either
Frequency or Period is available for this setting.

Delay Offset Sets the offset amount of the delay time.

Delay Mode Selects Long Delay on/off.

Clock Range Sets the clock range when Long Delay is on.

Vector Rate Vector rate (viewed only)

Internal Clock,
PLL Input,
External Reference
Input,
External Clock Input

Shows current clock source or the frequency of the external clock
signal.

Group Shows the group name when View by Group is selected.
Alternatively shows both the group name and channel number when
View by Channel is selected.

CH Shows the physical channel assigned in the Channel Group window.

Timing Window
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Table 2--16: Setup items for Timing window (cont.)

Items Description

Format Selects NRZ, RZ or R1 for the pattern format.

Delay Sets the lead delay (time or percentage).

PW/Duty/Cross Point Sets the pulse width or the duty when the format is set to RZ or R1.
Any of Duty(%), Pulse Width(s) or Trail Delay(s) is available for this
setting.

If the format is set to NRZ and the DTGM30 output module is
installed, you can change the cross point location by shifting the
rising or falling edge.

Slew Rate Sets the slew rate (V/ns). Unavailable for any channel to which a
DTGM30 channel has been assigned.

Polarity Selects Normal or Invert for the polarity of the pattern.

Channel Addition Sets the channel addition. Selects from Normal, XOR, or AND.
If the odd CH is assigned to physical channel, Normal and XOR can
be selected. If the even CH is assigned to physical channel, Normal
and AND can be selected.

Diff. Timing Offset Shifts timing for only inverted side of differential output.
Sets differential timing offset on/off and timing volume.

Edit Menu. The Edit menu of the Timing window contains the commands
common to the whole table and the commands available for the currently
selected item.

Table 2--17: Edit menus for Timing window

Items Description

Apply to Channels in the
Same Group

Sets the currently selected settings for all channels within the group.

Apply to All Channels Sets the currently selected settings for all channels.

Differential Timing Off-
set

Turns on or off the Differential Timing Offset of the currently selected
channels or group.

NRZ | RZ | R1 Selects the data format (when Format is selected).

Lead Delay | Phase(%) Specifies the rising position of a pulse (when Delay is selected).

Duty (%) | Pulse Width
(s) | Trail Delay (s)

Specifies which is used to set the falling position of a pulse (when
PW/Duty is selected).

Normal | Invert Sets the polarity (when Polarity is selected).

Normal | AND | XOR Sets the channel addition mode (when Channel Addition is selected).
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The Time Base window allows you to specify the clock source, trigger source, or
event signal.

Figure 2--13: Time Base window

Table 2--18 shows setup items in the Time Base window.

Table 2--18: Setup items for Time Base window

Items Description

Clock Source Selects clock source.

Internal Use internal clock.

External 10MHz Refer-
ence

Use 10 MHz reference clock connected to 10 MHz Reference In.

External PLL Input: Use external PLL signal connected to Phase Lock In.

External Clock Input: Use signal connected to External Clock In as an external clock.

Clock Output Sets the clock output parameters.

Amplitude Sets clock output signal amplitude.

Offset Sets offset.

Term.R Sets termination impedance.

Term.V Sets termination voltage.

Output On Specifies on/off of clock output.

Time Base Window
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Table 2--18: Setup items for Time Base window (cont.)

Items Description

Trigger Sets the trigger parameters.

Source Selects trigger source from internal/external.
Specifying Internal allows to set the Interval.
Specifying External allows to set the Level, Slope and Impedance.

Slope Specifies the trigger point (rising edge or falling edge of external
trigger signal). Selects either Positive or Negative.

Impedance Specifies external trigger impedance. (50 Ω or 1 kΩ)

Interval Specifies internal trigger interval.

Level Specifies external trigger level.

Event Input Sets the event input signal parameters.

Polarity Specifies rising or falling edge. (Normal or Invert)

Impedance Specifies event signal input impedance. (50 Ω or 1 kΩ)

Threshold Specifies event signal input threshold level.

There is no Edit menu on this window.
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A sequence is a data structure of one or more combined blocks, where the data
timing generator can output more complex pattern. The Sequence window allows
you to define the blocks, the output sequence, the jumping method, and other
sequence conditions.

Figure 2--14: Sequence window

Table 2--19 shows setup items in the Sequence window.

Table 2--19: Setup items for Sequence window

Items Description

Label Sets the line name. Accepts up to 16 characters for each label name
and defines up to 8,000 lines. Labels defined may be used as
destinations of Event Jump To and/or Go To.

Wait. Trig. Specifies whether the system waits for triggering before outputting
the line. Selects On or Off (blank).

Block/Subsequence Specifies the name of the block or subsequence to be output on the
line. Accepts up to 32 characters for each name.

Repeat Specifies the number of repetitions of the block or subsequence.
Accepts an integer from 1 to 65,536 or Infinite.

Event Jump To Specifies the label of the line to which control jumps when an event
occurs while the contents of the current line are being output. If the
cell is left blank, control will not jump.

Sequence Window
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Table 2--19: Setup items for Sequence window (cont.)

Items Description

Go To Specifies the label of the line to which control jumps unconditionally
after the contents of the current line are output. If the cell is left
blank, control goes to the next line.

Sequencer Mode Selects hardware sequence or software sequence.

Jump Mode Selects event jump (external event signal, front panel button, remote
commands) or command jump which is controlled by remote
commands.

Jump Timing Selects ASync which jumps immediately or Sync which does not
jump (waits for the completion of current blocks outputs).

Edit Menu. The Edit menu of the Sequence window contains commands not only
for the line operations, but also for the currently selected item.

Table 2--20: Edit menus for Sequence window

Items Description

Edit Edits Label, block name, subsequence name, or jump destination.

Wait Trigger Selects On or Off of Wait Trigger (when Wait Trig. is selected).

Infinite Selects Infinite for Repeat count (when Repeat is selected).

Delete Line Deletes the line that active cursor is placed.

Insert Line Before Inserts a blank line immediately above the line that active cursor is
placed.

Insert Line After Inserts a blank line immediately under the line that active cursor is
placed.

View Listing Changes the current window display to Data-Listing window, where
shows selected blocks. This menu selection is available when the
block name is selected.

View Waveform Changes the current window display to Data-Waveform window,
where shows selected blocks. This menu selection is available when
the block name is selected.

View Subsequence
Definition

Changes the current window display to Subsequence window, where
shows selected subsequences. This menu selection is available
when the subsequence is selected.
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A subsequence is a suite of the blocks used in the main sequence. In this window
you can define the subsequences that are used in the sequence.

Figure 2--15: Subsequence window

Subsequence List (left) contains the names of the currently defined subse-
quences. You can define up to 50 subsequences.

The right table lists the contents of the subsequence selected. For each subse-
quence, you can define up to 256 lines.

Table 2--21: Setup items for Subsequence window

Items Description

Block Specifies the name of the block to be output on the line. Accepts up
to 32 characters for each block name.

Repeat Specifies the number of repetitions of the block. Accepts an integer
from 1 to 65,536, but does not accept Infinite.

Subsequence Window
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Edit Menu. The Edit menu of the Subsequence window contains commands not
only for the line operations, but also for the currently selected item.

Table 2--22: Edit menus for Subsequence window

Items Description

Delete Line Deletes the line that active cursor is placed.

Insert Line Before Inserts a blank line immediately above the line that active cursor is
placed.

Insert Line After Inserts a blank line immediately under the line that active cursor is
placed.

View Listing Switches the window display to the Data-Listing window, where
shows selected blocks. This menu selection is available when the
block name is selected.

View Waveform Switches the window display to the Data-Waveform window, where
shows selected blocks. This menu selection is available when the
block name is selected.
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In this window you can set the parameters required for jitter generation. The
jitter generation is available only for Slot A, CH1.

Figure 2--16: Jitter Generation window

Table 2--23: Setup items for Jitter Generation window

Items Description

Jitter Generation on Slot
A CH1

Off: Turns off jitter generation.

All: Applies a jitter to the whole pattern of Slot A Ch1.

Partial: Partially applies a jitter to the pattern of Slot A Ch1.
The partial jitter is generated at the point logical channel set to 1.
You can select the logical channel using Partial By field.

Profile Selects jitter profile.

Edge Specifies the edge to apply a jitter.

Frequency Sets the repetitive frequency of the profile.

Amplitude Set the profile amplitude and jitter width. For the unit, you may select
either s (seconds) or UI (Unit Interval, 1 clock period of data timing
generator). Specifies peak-to-peak or RMS values.

There is no Edit menu on this window.

Jitter Generation Window
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In this window you can set the parameters of the DC output located at the front
right of the data timing generator. Eight channel DC outputs are equipped with a
mainframe. While the system configuration is in Master-Slave mode, the master
machine can control the DC Outputs of all the slave machines.

Figure 2--17: DC Output window

The DC Output window allows you to set the following for each channel. See
Table 2--24.

Table 2--24: Setup items for DC Output window

Items Description

Level Sets the DC level value.

H Limit Sets the maximum value of DC level setting range.

L Limit Sets the minimum value of DC level setting range.

Limit Turns on or off the High/Low limit function.

Output On Powers the output on or off.

DC Output Window
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Edit Menu. Provides the predefined levels.

Table 2--25: Edit menus for DC output window

Items Description

TTL. High Sets 2.50 V.

Low Sets 0.00 V.

CMOS 5 V High Sets 5.00 V.

Low Sets 0.00 V.

CMOS 3.3 V High Sets 3.30 V.

Low Sets 0.00 V.

ECL High Sets --0.90 V.

Low Sets -- 1.70 V.

PECL High Sets 4.10 V.

Low Sets 3.30 V.

LVPECL High Sets 4.10 V.

Low Sets 1.60 V.

LVDS High Sets 1.40 V.

Low Sets 1.00 V.

TMDS High Sets 3.30 V.

Low Sets 2.80 V.

RSL High Sets 1.80 V.

Low Sets 1.00 V.

CML High Sets 0.00 V.

Low Sets -- 0.41 V.



Operating Basics

DTG5078 & DTG5274 Data Timing Generator User Manual 2--37

Using the Menu System

This section describes the basic operation of the data timing generator using the
front panel keys, buttons and knob.

Pushing the front panel MENU button displays the last menu you selected on the
menu bar.

Figure 2--18: Menu selection

� To navigate through a pull-down menu list, use the Up or Down arrow key.
To show a submenu (�), use the Right arrow key. You can also use the knob
instead of the arrow keys to navigate through a menu list.

� If you press the Left or Right arrow key on a menu item not having any
submenu, you can navigate through the menu bar.

� Once you push the SELECT button, the menu is determined.

� To cancel the menu display, push theMENU button.

� To use the ESC key to cancel the menu display, press the ESC key twice.
When you press it only once, the menu bar is still active although the display
disappears. In this state, you can navigate through the menu bar by pressing
the Up, Down, Left, or Right arrow key.

Hint: Pressing the ALT key activates the menu bar. Then, you can make a menu
selection using the Up, Down, Left and/or Right arrow keys.

Pop-up Menu Items. In the individual data timing generator windows, selecting
the setup item and pushing the front panel SELECT button displays the pop-up
menu item(s) corresponding to the selected item. Refer to Figure 2--20 on page
2--39 for a pop-up menu example.

Menu System
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The data timing generator windows contain various items of information. Input
of numeric values such as the output level and clock rate, selection of the trigger
source and other settings, creation of the pattern data, and other operations can
be performed.

1

2

3

4

Figure 2--19: Window operation 1: Time Base window

1. To select the parameter with radio buttons such as Clock Source or Trigger
Source, use the Up, Down, Left and/or Right arrow key.

2. To navigate through the Clock Source, Output Amplitude, and other similar
items, use the TAB key. You can navigate through these in the reverse
direction by pressing the SHIFT and TAB keys simultaneously.

3. To place the check sign into a check box such as Output On, use the
SPACE key.

4. Any numeric input box has a unit attribute according to the setting. The unit
attribute s is for the time, V for the voltage, Ω for the resistance, or nothing
for the count or size. To enter a numeric value, use either numeric keys or the
knob. For details, see Numeric Input on page 2--44.

Using a Window
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1

2 3

4 6

5. Pop-up menu items

Figure 2--20: Window operation 2: Timing window

A table appears in the Timing, Level and Data-Listing windows. Figure 2--20
shows Timing window.

1. The information area shows the selected parameter information.

2. In the parameter box you can enter numeric values or characters.

3. A Pattern Display Box that contains a pattern corresponding to the Format or
Delay appears.

4. The parameter area at the lower part of the window lists the setting parame-
ters such as Frequency or Delay. The parameters that can be set for each of
the channels are listed in tabular form.

5. A pop-up menu appears when an item is selected in the table, pushing the
SELECT button or right-clicking the mouse on the selected item displays
the menu items corresponding to the item.

For Format, Polarity, or Mode selections, first display the pop-up menu, then
select the parameter.

6. The scroll bar is activated when the mouse is attached. Scroll the cursor to
display the hidden tables outside the display area.

� To navigate through items in the parameter area, use the TAB key.
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� To move the cursor through items within the table, use the Up, Down, Left
or Right arrow key.

� In Polarity, you can toggle between its two options by pressing the SPACE
or ENTER key.

� For numeric parameters such as Delay or PW/Duty, enter numeric values
using numeric keys or the knob. See Numeric Input on page 2--44.

� You can select either View By Channel or View By Group window display.
You can toggle between the two by using View menu.

� You can select On or Off of Limit or Output parameter by pressing the
SPACE or ENTER key in the Level window.

1

2

3

Figure 2--21: Window operation 3: Data-Listing window

In the Data-Listing and Data-Waveform windows you can create or edit data. The
edit window allows you to use the cursor and markers to define the edit range.

1. You can move the cursor in the vector or bitwise direction by using the Up,
Down, Left, or Right arrow key.

To specify the region, use the Up, Down, Left, and/or Right arrow keys
while pressing the SHIFT key. Specifying the region is available within the
same group. It is not allowed to define the region beyond the group.
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2. The scroll bar is activated when the mouse is attached. Scroll the cursor to
display the hidden tables outside the display area.

3. The two markers are used to specify the range. To move the markers, select
Move Marker To... from the Edit menu to display the Move Marker To
dialog. Then, enter the value to each field.

� You cannot move the markers with front panel keys or knob.

� You can move the markers by dragging a mouse in the Data-Waveform
window.

� You can select either View By Channel or View By Group. You can toggle
the two displays by using the View menu.
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Figure 2--22: Window operation 4: Channel Group window

In the Channel Group window you can assign the logical channels and physical
channels. The Group List on the left window pane lists the logical channels in
the Group column. The Channels on the right side list the physical channels.

1. You can toggle between Group List and Channels using the TAB key.

2. To select a logical or physical channel, use the Up, Down, Left, and/or Right
arrow keys.

3. After selecting the physical channel in the Channels, pressing the ENTER
key makes the physical channel assign to the logical channel preselected in
the Group List. When you are using the mouse, you can make the assign-
ment by clicking the mouse in the physical channel box.

� With the physical channels listed in the Group List (CH column), bullets are
added to the boxes associated with the assigned physical channels in the
Channels.

� After you have selected one of already assigned physical channels (indicated
by bullets) in the Channels, pressing the ENTER key resets (deassigns) the
assignment with the logical channel. If you are using the mouse, you can
reset the assignment by clicking the mouse in the assigned physical channel.

� To create, resize or deassign a group, or create a predefined group, use the
Edit menu or the pop-up menu displayed by pushing the SELECT button.
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Figure 2--23: Window operation 5: Sequence window

In the Sequence window you can create a sequence by combining blocks and
subsequences. This window is also in tabular form like other windows. This
window allows you to input the characters.

1. To move the active cell through the table, use the Up, Down, Left, and/or
Right arrow keys.

2. Any cell in this window accepts characters and digits you entered. To enter
characters to Label or Event Jump To column, press the front panel ALPHA
key to activate the text input mode and then use numeric keys. See Text Input
on page 2--45.

3. To specify On for Wait Trig. or Inf. for the Repeat, use the Edit menu. You
can also use the SELECT button to display the pop-up menu. See page 2--37
for information on how to use the data timing generator menu system.

4. The blocks and subsequences already defined in the Blocks or Subsequence
window are listed in the Edit menu, which allows you to specify the block
or subsequence in the Block/Subsequence column. You can also specify the
the block or subsequence by using the SELECT button and pop-up menu.
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Any numeric input box has a unit attribute according to the setting. The unit
attribute s is for the time, V for the voltage, Ω for the resistance, or nothing for
the count or size. The data timing generator recognizes the range of the
acceptable parameter values. If you enter a value outside the valid range, the
maximum or minimum value will be set automatically. To enter a numeric value,
use either numeric keys or the knob.

Using the Numeric Keys. Auxiliary unit keys such as k/m and M/� are available.
For k (kilo-), m (milli-), M (mega-), and their related units, the one suitable for
the parameter is selected automatically.

Example 1: Amplitude

� If you press 0, ., 5, and ENTER in this order, 0.5 V is entered.

� If you press 5, 0, 0, and k/m in this order, 0.5 V (500 mV) is entered.

Example 2: Term Z

� If you press 5, 0, and ENTER in this order, 50 Ω is entered.

� If you press 1 andM/� in this order, 1 MΩ is entered.

Using the Knob. If a numeric value is accompanied with an underbar, you can use
the knob for editing it. The digit accompanied with an underbar can be edited.

To move the underbar to the target digit to be edited, use the Left and/or Right
arrow key under the knob. See Figure 2--1 for the location of the key.

A numeric value accompanied
with underbar

Using the External Keyboard. Numeric keys above the alphabetical letter keys, not
those on the numeric keypad, are available on the external keyboard. The k
(kilo-), M (mega-), G (giga-), m (milli-), � (micro-), n (nano-) and p (pico-) keys
are available for auxiliary units.

Numeric Input
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To enter text from the front panel, use the ALPHA key and numeric keys. Push
the ALPHA key to activate the text input mode. In this mode, you can enter
characters that are printed above each numeric key. The ALPHA key’s LED stays
lit if the text input mode is selected.

� Pressing the ALPHA key switches between the numeric and text input
modes.

� By pressing a numeric key repeatedly, the characters indicated above the key
are displayed in order.

Example: Pressing the 8 key displays a at the caret. If you press the 8 key
repeatedly, the character changes to b, c, A, B, C and 8 in order.

� When you press another numeric key or the Left or Right arrow key, the
character currently displayed is determined and the caret moves. By pressing
the ENTER key or another numeric key, the character is also determined.

� If you press a key unrelated to text input or the ESC key, or use the ENTER
key to determine the character, the mode automatically changes from text
input to numeric input.

To save or load the setup file or import data that has been created on another
device, use the Windows standard file I/O dialog box. The data timing generator
file operations are the same as the general PC file operations. If the mouse is not
used, several restrictions are applied to the file operations.

Selecting a file. Do the followings steps to select a file without using a mouse.

1. Press the TAB key repeatedly to activate the file view.

Activates
the file
view

Text Input

File Operations
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2. Do the following substeps to specify the file within the file view area.

� Use Up or Down arrow key to select the folder.

� Press the ENTER key to open the folder.

� Press the BKSP key to move the folder hierarchy up.

Selects folder
with up or down

arrow key

3. Use Up or Down key to specify the file.

Selects file with
up or down
arrow key

� Press the ENTER key to open the file.

� Press the BKSP key to return to the upper folder.
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Table 2--26 summarizes the data timing generator key operations.

Table 2--26: Key operations

Items Description

MENU button Displays the last menu you opened on the menu bar.

TAB key Moves the focus through items in the window. Pressing SHIFT and
TAB keys simultaneously reverses the moving direction.

Up/Down/Left/Right
arrow keys

Moves the cursor through items on the menu, moves the caret during
text input, or selects a radio button.

SHIFT + Up/Down/Left/
Right arrow keys

Selects multiple items (Data-Listing/Data-Waveform window), or
shifts the current line (SHIFT + Up/Down arrow key only; Timing/Lev-
el window).

Knob Changes a numeric value, moves the cursor through menu items,
moves the focus in a table or list, moves the cursor through the
Data-Listing or Data-Waveform window, toggles between multiple
items for a parameter in the Timing/Level window (NRZ/RZ/R1,
On/Off, Normal/Invert, Normal/AND/XOR, etc.), or selects an item
from a combo box.

Digit Select arrow keys Located just below the knob. Moves the cursor through digits while
using the knob to enter a numeric value. Refer to page 2--2.

SPACE key Turns on or off the check sign in a check box, or toggles between
two options for a parameter in the Timing or Level window (On/Off,
Normal/Invert, etc.).

ALT key Activates the menu bar.

ALT + ESC key Switches the active application.

ALT + TAB key Switches the application (selected with icon display).

ALT + SPACE key Displays window control menu. You can move/resize/close the
window.

ALT + F4 Exits the application. (Available only from the external key board)

ESC key Cancels text input or a dialog box. Cancels display of a menu
opened with the SELECT key. To cancel a menu opened with the
MENU key, press ESC key twice.

CTRL + TAB key Switches the active window in the application.

CTRL + Left/Right arrow
key

Moves the cursor between digits during numeric input.

CTRL + Up/Down key Increments or decrements the value during numeric input.

CTRL + ESC key Displays the Windows Start menu.

CTRL + ALT + DEL key Forcibly exits the application. (Available only from the external key
board)

Key Operations
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As the standard accessories, a USB keyboard and USB mouse are shipped with
the data timing generator. Though it is possible to operate the instrument only
with front panel controls, attaching the mouse and external keyboard to the data
timing generator mainframe makes the operation more easily. Read the following
topics related to the mouse and external keyboard.

When you set up the Windows operating system or perform the system recovery,
the external keyboard and mouse are required.

You can connect or remove the USB devices while the data timing generator
powered on.

Mouse.

� Using a mouse allows you to access the toolbar icons, each window buttons
and scroll bar which cannot be accessed from the data timing generator front
panel controls.

� In the data editing windows such as Data-Listing or Data-Waveform, or in
the setup windows such as Timing or Level, you can access the area you
cannot access from the keyboard. By dragging, right clicking or left clicking
the mouse allows you to access those functions.

Keyboard.

� The Delete and Back space (BS) functions are assigned to a single key. To
use it as BS, press Fn+Delete. If you want to use a key as labeled on the key
front (such as BS, F1, F2...), press it while holding down the Fn key.

� The � key operates as the Windows key.

� You can assign the Delete key to the BS key using a SW3 DIP switch
located on the back. In this case, you can input Delete by pressing Fn+’. For
details of the DIP switches, refer to the underside of the keyboard.

� After you power on the instrument for the first time, you have to set up
Windows. Connect the keyboard supplied with the instrument before turning
on the power.

NOTE. If you need to perform the system recovery, you must use a PS/2 keyboard

and PS/2 mouse.

Keyboard and Mouse
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Data Structure

This section contains the following two subsections, which provides background
information on the DTG5000 Series Data Timing Generator data structure.

� Internal Pattern Data section explains the data timing generator objects such
as channel, group, block and sequence.

� Grouping and Channel Assignment section explains the definition of groups
and provides basic information on how to use the Channel Group window.

Internal Pattern Data

This section explains the meanings of the data included in the windows. The data
in the DTG software consists of the channel, group, block, and sequence objects.
This section details them in order.

Logicalchannel

Logicalchannel

Logicalchannel

Logicalchannel

Logicalchannel

Logicalchannel

Logicalchannel

Logicalchannel

Logicalchannel

Logicalchannel

Logicalchannel

Logicalchannel

Logicalchannel

Logicalchannel

Logicalchannel

Logicalchannel

Group 01 Group 02 Group 03

1 2 3 4

A B C D

Block

Physical Channels

Channel Assignment

1 2 3 4 1 2 3 41 2 3 4

Figure 3--1: Channels, groups, blocks and channel assignment
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The data timing generator has two types of channels: logical and physical.
Logical channels represent one-bit pattern data. The number of logical channels
is 32 (= 4 channels x 8 slots) for the DTG5078, or 8 (= 2 channels x 4 slots) for
the DTG5274.

Logical channels themselves do not have the concept of length. The length of the
pattern data on a logical channel is the block size defined in the Blocks window.
Each piece of the pattern data has a value of 0 or 1. To create the pattern data,
you can use the Data-Listing or Data-Waveform window.

One of the key features of the data timing generator is that each logical channel
has its attribute value of the output setting parameters such as the output level,
pulse width or delay time. You can set these parameters using the Level and/or
Timing windows.

Physical channels are defined as the hardware channels of an output module
installed in the data timing generator mainframe. Each of the DTGM10 or
DTGM20 output module installed in the DTG5078 mainframe has four physical
channels. Each of the DTGM10 or DTGM20 module installed in the DTG5274
mainframe or each of the DTGM30 module installed in the DTG5078 or
DTG5274 mainframe has two physical channels.

The number of physical channels available for the system is determined by the
mainframe type and the types and number of output modules installed.

The DTG5000 software has the output setup parameters, such as the output level
or clock frequency, in its logical channels. To perform the actual data pattern
outputs, do the following:

� First, specify the physical channels to output the data within the logical
channels.

� Next, send the output setup parameter to the physical channels to operate the
hardware properly.

To associate the logical channel with the physical channel (this is also called
channel assignment), use the Channel Group window. Refer to Window
Operation 4: Channel Group Window on page 2--42.

Logical Channel

Physical Channel
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A group is defined as a set of logical channels. Grouping function is especially
useful depending on the DUT. Several channels are sometimes used with the
same output level and data format. In such case, handling the multiple channels
as one group is a useful method.

The number of logical channels that the system can accept is determined by the
mainframe (32 for the DTG5078 or 8 for the DTG5274). In the Master-Slave
operation mode, the number increases with the number of mainframes. The
number of groups depends on how many groups the user divides the logical
channels. The total number of logical channels of each group cannot exceed the
number of logical channels that the system can accept. By default, every logical
channel is divided into an eight-channel group. To add a new group, you have to
delete some groups or decrease the number of logical channels in a group to
secure the logical channels required for the new group.

To create, delete, rename or resize a group, use the Channel Group window.

A block is defined as a set of groups that consist of logical channels. The block
is an elementary data of signal output. To specify the block length, use the block
size located in the Blocks window. The block size represents the pattern data
length, or vector length. The block width is the sum of bit width in the group to
which it belongs, that is, the total number of logical channels.

By default, one block whose size is 1000 named Block1 is created.

Creating multiple blocks enables you to perform the repetitive signal outputs by
the blocks or sequential outputs with jumps. Even if two or more blocks exist in
the system, only one method can be used for either grouping or channel
assignment.

To create, rename or resize a block, use the Blocks window.

Use the Data-Listing or Data-Waveform window to edit values (0 and 1) in the
individual pattern data. Editing is possible by the block unit. To specify the
block to be edited, you can use Select Block... from the Edit menu of the
Data-Listing or Data-Waveform window, or use View Data-Listing or View
Data-Waveform from the Edit menu of the Blocks window.

To set the voltage output setting parameter, use the Level window. To set the
timing output setting parameter, use the Timing window. Both parameters can be
set by the channel unit (except for clock frequency), not by the block unit.

A sequence consists of blocks and subsequences. As the subsequence elements,
one or more block names and the repetition of the blocks are defined. Using a
sequence, you can output the complex signals by defining blocks, number of
repetition of subsequence, and jump conditions.

Groups

Blocks

Sequence
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By default, a sequence that infinitely repeats the Block1 is provided. To create a
sequence or subsequence, use the sequence table in the Sequence window or
Subsequence window.

Block1 x 10

Block2 x 20

Block3 x 10

Sequence window

Data--Waveform window

Data--Listing window

0100101001110
0010001000100
110011001

Hi 1.5 V

Lo 0.0 V

Level window

Freq 375 MHz

Delay 1 ns

Duty 50 %

Timing window

Channel Group window

Group

Group

Block1

Block2

Block3

Group

Pattern Memory

A B

Hardware channels

Channel Assignment

Grouping

Output
Setup

Edit

1 2 3 41 2 3 4

Figure 3--2: Concept of data and window
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Grouping and Channel Assignment

Grouping is to collect channels in a single group to enable setup, edit or display
by group. To define a group or perform a channel assignment, use the Channel
Group window. You can use the grouping function only in the Data Generator
mode.

A group is defined by the name and the channels included in the group. The
defined group and channels are used for display by the channel or by the group
in the Data-Listing, Data-Waveform, Timing, or Level window.

The channels to be defined are logical channels but not physical channels, which
are actually installed to the hardware. The pattern data you created by pattern
edit and the setting parameters such as the voltage and/or delay are attributes
with logical channels.

To output a signal, you must assign the previously defined logical channels to
physical channels. See Figure 3--3.

� Assign only one physical channel to one logical channel.

� Channel assignment can be performed, regardless of the bit sequence in the
group; any physical channels can be assigned to logical channels as desired.

� You can define the logical channels without being assigned to physical
channels.

� The physical channels that are not assigned to the logical channels do not
output any signals.

AAA:00

AAA:01

AAA:02

AAA:03

AAA

(4 bits)

BBB:00

BBB:01

BBB:02

BBB:03

BBB:04

BBB

(5 bits)

CH1

CH2

CH3

CH4

CH1

CH2

CH3

CH4

CH1

CH2

S
lotA

S
lot
C

S
lot
B

Group Logical
Channels

Physical
Channels

Unable to use the CH1 which is
not assigned to logical channel.

You cannot assign two logical
channels to one physical channel.

The logical channel which is not
assigned to any physical channel
can be used.

Crossing is acceptable.

X

Figure 3--3: Channel assignment

Defining a Group

Assigning a Channel



Data Structure

3--6 DTG5078 & DTG5274 Data Timing Generator User Manual

To define a group or perform channel assignment, use the Channel Group
window.

Figure 3--4: Channel Group window

The default group name(s) appear in the Group List represent the maximum
number of logical channels which can be used with mainframe, and they are
grouped by eight channel per one group. The groups are independent of the
installed output module(s).

Group Name. Assign a name to each group for identification. You can specify any
32-character or shorter string for a group. The name is case-sensitive, and the
default is GroupXX.

Definable Number. Equal to or less than the number of physical channels
supported by the mainframe. Up to 96.

Number of Channels. 1 to 96.

Predefined Grouping Options. The data timing generator provides three user-se-
lectable predefined options for grouping:

� 8 channels per group

� 1 channel per group

� All channels in one group

Channel Group Window

Group List
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To create a new group, there must be a logical channel not assigned to a group.
By default, every logical channel has been assigned to groups in the data timing
generator mainframe. You must delete several groups to make the logical
channels available before creating a new group.

1. Push the front panel MENU button.

2. Select the Edit menu, and then select New Group....
Alternatively, place the mouse pointer in the Group List table and right-click,
then select New Group....

3. The Grouping dialog box appears.

4. Enter a group name and the number of bits (number of logical channels) in
the dialog box.

5. Select OK to create a new group.

You can rename an existing group or change the number of its logical channels.

1. If the Group List is not activated on the screen, activate it by pressing the
TAB key.

2. Select the target group using the Up or Down arrow key.

3. Push the front panel MENU button.

4. Select the Edit menu, and then select Rename/Resize Group....
Alternatively, place the mouse pointer in the Group List table and right-click,
and then select the Rename/Resize Group....

5. Edit the group name and the number of bits (the number of logical channels)
in the Grouping dialog box.

6. Select OK to complete the change.

Creating a New Group

Renaming and Resizing a
Group
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You can delete the particular group(s) you selected or all the groups.

1. Activate the Group List in the Channel Group window.

2. To delete a group, select the group by using the Up or Down arrow key.

3. Push the front panel MENU button.

4. Select the Edit menu, and then select Delete Group or Delete All Groups.
Alternatively, place the mouse pointer in the Group List table and right-click,
and then select the Delete Group or Delete All Groups.

5. Select the menu option (Delete Group or Delete All Groups) to display the
confirmation dialog box.

6. Select OK to delete the group(s).

The following three combinations of a group and its logical channel are provided
in the data timing generator.

� 8 channels per group

� 1 channel per group

� All channels per group

To select one of these options, do the following.

1. Activate the Group List in the Channel Group window.

2. Push the front panel MENU button.

3. Select the Edit menu, and select Preset, and then select 8 Channels per
Group or 1 Channel per Group or All Channels in One Group.

Alternatively, place the mouse pointer in the Group List table and right-click,
then select the Preset, and then select 8 Channels per Group or 1 Channel
per Group or All Channels in One Group.

4. Select the menu item to display the confirmation dialog box.

5. Select OK to create the group.

The physical channel is identified by the mainframe number (1 to 3; for
Master-Slave configuration), slot location (A to H), and channel number (1 to 4).

The installed physical channels are displayed in the right window pane of display
area. Any channel indicated by a bullet in a white rectangle has already been
assigned to a logical channel.

Deleting a Group

Selecting a Preset
Grouping Option

Channels
Physical Channel
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Do the following steps to perform the channel assignment.

1. Activate the Group List in the Channel Group window.

2. Select the target logical channel with the Up or Down arrow key.

3. Activate the Channels with the TAB key.

4. Select a physical channel with the Up/Down/Left/Right arrow keys.

5. Push the SELECT button to complete the assignment. The physical channel
name is displayed in the CH column of the Group List, indicating that the
assignment is complete.

6. For the logical channel in the left of Group List, the next lower line is
selected automatically. The channel assignments can be performed in
sequence by repeating the selection of a physical channel in the right
Channels.

The Auto Assign function allows you to assign the physical channels (1-A1,
1-A2, 1-A3...) to the logical channels in the Group List sequentially.

1. Activate the Group List in the Channel Group window.

2. Push the front panel MENU button.

3. Select the Edit menu, and then select Auto Assign.

Alternatively, place the mouse pointer in the Group List table and right-click,
then select Auto Assign.

4. A confirmation dialog box appears.

5. Select OK to perform the Auto-Assign.

Assigning a Channel

Using the Auto Assign
Function
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You can de-assign a physical channel you selected. You can also de-assign all the
physical channels currently assigned to logical channel(s).

1. Activate the Group List in the Channel Group window.

2. To de-assign a particular channel, select the channel with the Up or Down
arrow key.

3. Push the front panel MENU button.

4. Select the Edit menu, and then select De-assign or De-assign All.
Alternatively, place the mouse pointer in the Group List table and right-click,
then select the De-assign or De-assign All.

5. A dialog box appears to prompt you for confirmation. Select OK.

6. The channels you selected are de-assigned.

De-assigning a Channel
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Tutorials

This section contains tutorials to help you learn how to operate the DTG5000
Series Data Timing Generator. These tutorials provide a good introduction to the
following basic features of the data timing generator.

The data timing generator has a high degree of flexibility in combination of the
mainframe and output modules. In this section, you can perform the tutorials
under the assumption that the eight channel output modules (two DTGM10) are
installed in the data timing generator mainframe (DTG5078).

To familiarize the first-time user with the data timing generator, the following
tutorials focus on the front panel operations. In the actual signal output tasks,
you can perform the operations more easily by using a mouse and a keyboard.

Install two DTGM10 output modules to slot A and slot B of the mainframe.
Refer to Output Module on page 1--7 for installation and removal of output
module. Then, power on the mainframe. Refer to Powering On the Data Timing
Generator on page 1--10.

The data timing generator starts in the mode in which it was powered off last
time. The offline mode enables you to set the whole process from creating
pattern data to setting up output parameter on the PC, except for the data timing
generator hardware control. To output a pattern, you must operate the data timing
generator in the online mode. If the data timing generator is running in the
offline mode, do the following steps to change the mode to online.

Indicates the
DTG is
operating in the
offline mode.

Figure 4--1: Confirming Offline mode

1. Exit the DTG5000 software.

a. Push theMENU button, and then select Exit from the File menu using
the Up, Down, Left, and/or Right arrow key.

Before Applying Power to
the Mainframe

Online Mode and
Offline Mode
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b. Push the SELECT button to exit the DTG5000 software.

2. Start the DTG5000 Configuration Utility software.

a. Press the CTRL+ESC keys to open the Windows Start menu.

b. Using the Up, Down, Left, and/or Right arrow key, select Programs -->
Tektronix --> DTG5000 --> DTG5000 Configuration Utility, and then
press the ENTER key.

3. Use the DTG5000 Configuration Utility to set the mode to Online.

a. Press the TAB key repeatedly to activate the Mode selection.

b. Select Online using the Left or Right arrow key.

Select
Online

Figure 4--2: Select the online mode

c. The DTG5000 Configuration Utility window changes to online mode.
Press the ENTER key.

d. A dialog box appears to prompt you to restart the data timing generator.
Press the ENTER key.

4. Restart the DTG5000 software.

a. Press the CTRL+ESC keys to open the Start menu.

b. Using the arrow key, select Programs --> Tektronix --> DTG5000 -->
DTG5000, and then press the ENTER key to restart the DTG5000
software.
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There are two types of arrow keys on the data timing generator front panel.

Up, Down, Left, and Right arrow keys. These arrow keys are generally used to
move the cursor position or to navigate the menu items.

Digit Select arrow keys. These arrow keys are used to specify the digit to be
edited while using the knob to enter a numeric value.

Up, Down, Left, Right
arrow keys

Digit Select
arrow keys

In the following tutorials, the Up, Down, Left, and Right arrow keys are simply
called “arrow keys”.

Arrow Keys
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Tutorial 1: Pulse Generator Mode

In this Tutorial 1, operate the data timing generator in the Pulse Generator mode,
and run the mainframe to output a pulse. Verify that the output signals vary by
changing several parameters.

Starting the DTG5000 software causes the data timing generator to start in the
Data Generator mode.

1. Push the front panel MENU button, select Default Setup from the File
menu using the arrow keys, and then push the SELECT button.

2. Push the front panel PULSE GEN button to enter the Pulse Generator mode.
The Timebase window appears. In this window, you can set up parameters
related to the clock, run mode, and trigger. Use the default settings in this
tutorial. Confirm that Internal is selected in the Clock Source and Continu-
ous is selected in the Run Mode.

Confirm that
the Pulse Gen
is displayed

Confirm that
the Internal is
selected

Confirm that
the Continuous
is selected

Figure 4--3: Time Base window (Pulse Generator mode)

Starting Pulse Generator
Mode
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1. Push theMENU button, select Level from the Settings menu using the
arrow keys, and then push the SELECT button. Alternatively, push the front
panel LEVEL button.

The Level window appears. In this window, you can set up parameters
related to the output level. By default, this window shows the High level
(1.000 V) and Low level (0.000 V) settings. You can use the default settings
in Tutorial 1. For the Level window screen sample, see Figure 4--4.

2. Push theMENU button, select Timing from the Settings menu using the
arrow keys, and then push the SELECT button. Alternatively, push the front
panel TIMING button.

The Timing window appears. In this window, you can set up parameters
related to the time base such as the output frequency, delay, and/or rise time.
For the Timing window screen sample, see Figure 4--5.

Output a signal with the default settings.

1. Push the front panel LEVEL button to open the Level window.

Figure 4--4: Level window (Pulse Generator mode)

2. Confirm that the View by Channel is selected in the View menu.

3. Do the following substeps to turn the Output on:

a. Move the cursor to Output 1-A1 using the arrow keys.

Browsing the Window

Output a Signal
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b. Push the SELECT button to open the pop-up menu, select On using the
arrow keys, and then push the SELECT button. The Output for the
1-A1 channel is set to On.

Alternatively, you can press the SPACE or ENTER key to toggle
between On and Off.

Output is
set to On

NOTE. When the cursor is placed in a table in the Level, Timing or other

windows, you can push the SELECT button to open the corresponding pop-up

menu that contains the commands for the current field. At the top, this menu

shows the setup parameter values specific to the item you selected. You can see

the same list in the Edit menu which you can access by pushing the MENU

button.

Select from
Pop-up
menu

c. Press the Down arrow key to move the cursor to the 1-A2 channel. Press
the SPACE key to switch the channel status from Off to On.

d. Turn the outputs of 1-A3 and 1-A4 channels to On in the same way. The
LEDs stay lit up on the output connectors.

4. Push the front panel RUN button to output the pulse signal.
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The following steps introduce a variety of operations you can perform in the
Level window.

1. Set the numeric values in the following ways.

a. Using the arrow keys, move the cursor to High for the 1-A1 channel.
Press the Digit-Select arrow keys under the knob to move the underscore
to the bottom of 1. You can change the value for the digit by turning the
knob. Change the setting to 2.000 V.

b. Using the Right arrow key, move the cursor to Low for the 1-A1
channel. Press the numeric keys -- and 1, and then press the ENTER key.
The Low is set to --1.000 V.

c. Using the Right arrow key, move the cursor to H Limit. Press the
numeric key 2, and then press the ENTER key. The H Limit is set to
2.000 V.

d. Push the SELECT button to display the pop-up menu. Using the arrow
keys, select the Apply to All Channels, and then push the SELECT
button. The H Limit for every channel is set to 2.000 V.

e. Using the Right arrow key, move the cursor to L Limit. Press the
numeric keys --, 0, . and 5, and then press the ENTER key. The L Limit
is set to --0.500 V.

f. Push the SELECT button to display the pop-up menu. Using the arrow
keys, select the Apply to All Channels, and then push the SELECT
button. The L Limit for every channel is set to --0.500 V.

g. Using the Right arrow key, move the cursor to Limit. You can press the
ENTER or SPACE key to toggle between Off and On.

h. If you set the Limit to On, the Low value you have set in Step 1-b
changes to --0.500 V. This is because the value you have set with the L
Limit applies to the Low value.

2. Use the Predefined Level to set the level.

a. Using the arrow keys, move the cursor to High for the 1-A2 channel.
Push the SELECT button to open the pop-up menu, select the
Predefined Level... using the arrow keys, and then push the SELECT
button. The Predefined Level dialog box appears.

Level Window Operations
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b. Select CML (into 50 Ω to GND) by using the arrow keys.

c. Select OK by pressing the TAB key, and then press the ENTER key.

d. Each parameter of the 1-A2 channel is set to the predefined value.

The 1-A2 is set to
predefined level

3. Select the Apply to All Channels to set all the channels to the same setting.

a. Move the cursor to High for the 1-A2 channel and push the SELECT
button, and then select the Apply to All Channels using the arrow keys.

b. Push the SELECT button to set the High value for every channel to
0.000 V.

c. Move the cursor to Term.V using the Right arrow key. If there is any
different setup parameter in Term.V cell, use the Apply to All Chan-
nels command to change the parameters.

4. By using the front panel ALL OUTPUTS ON/OFF button, you can turn on
or off the Output switch in the Output cell for each of the channels.

a. Currently, the 1-A1 through the 1-A4 channels are On, and the others are
Off.
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b. By pushing the ALL OUTPUTS ON/OFF button, you can toggle
between On and Off for all the channels. Push the button twice to turn on
all the channels.

When you push the ALL OUTPUTS ON/OFF button, all the channels are
turned off if there is any channel set to On. The Output for all the channels
toggles between On and Off each time you push the button.

The following steps introduce some of the operations you can perform in the
Timing window.

1. Push the front panel TIMING button to open the Timing window.

Figure 4--5: Timing window (Pulse Generator mode)

2. Do the following substeps to change the Duty setting of the pulse:

a. Using the arrow keys, move the cursor to PW/Duty for the 1-A1
channel.

b. Press the Digit-Select arrow keys to move the underscore to the unit
place.

c. Turn the knob to decrease or increase the Duty setting of the pulse. The
pulse width of output signal also varies concurrently. Change the setting
to 25.0 %.

d. Press the Down arrow key to move the cursor to PW/Duty for the 1-A2
channel.

Timing Window
Operations
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e. Push the SELECT button to open the pop-up menu.

You can display the same list in the Edit menu using either theMENU

button or the Left and/or Right arrow keys.

f. The menu contains Duty(%), Pulse Width(s), and Trail Delay(s). This
means you can select duty ratio (%), pulse width (time), or falling edge
(time) as the method for specifying the pulse width. You can select any
option.

Select the Pulse Width(s) using the Down arrow key, and then press the
ENTER key.

g. The values previously shown as 50.0% with Duty is shown asW
0.005000 �s. TheW stands for Width.

h. Press the numeric keys 2, ., and 5, then press the unit key G/n. Input of
0.002500 �s (= 2.5 ns) is complete. In this way, you can set a numeric
value by using the knob or numeric keys.

i. Press the Down arrow key to move the cursor to PW/Duty for the 1A-3
channel.

j. Push the SELECT button to open the pop-up menu, select the Trail
Delay(s) using the Down arrow key, and then press the ENTER key.

k. If you use the Trail Delay for setting, the values will be shown as T
0.005000 �s. Press the numeric keys 2, ., and 5, then press the unit key
G/n. Input of 0.002500 �s (= 2.5 ns) is complete.

3. Check the valid range setting.

a. Press the Right arrow key to move the cursor to Slew Rate.

b. The Slew Rate parameter is used to vary the pulse rising edge. The value
is currently shown as 1.30 V/ns. If the valid range of the parameter value
is not known, you can find the maximum and minimum valid values by
entering extremely large and small values.

c. Enter 9999 using numeric keys, and then press the ENTER key. The
value in the input box is set to 1.30 V/ns.

d. Enter --9999 using numeric keys, and then press the ENTER key. The
value in the input box is set to 0.65 V/ns.

e. Steps 3.c and 3.d conclude that this parameter can be set in the 0.65 V/ns
through 1.30 V/ns range.

f. Turning the knob can also increase or decrease the value in the valid
range.

4. Set the Polarity and Channel Addition parameters.
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a. Press the Right arrow key to move the cursor to Channel Addition for
the 1-A3 channel. The Channel Addition function allows you to output
the results from the composition of the signals of the current channel and
another channel.

b. In case you may not be sure what parameter values can be set, use the
pop-up menu by using the SELECT button. Alternatively, use the Edit
menu by using theMENU button and the arrow keys. At the top of the
menus, the parameter values you can set are listed.

c. Push the SELECT button to open the pop-up menu. From the displayed
menu items, you can select either Normal or XOR, and the Normal is
currently selected.

d. Select XOR using the Down arrow key, and then press the ENTER key.
You have set XOR (The XORed signal of the 1-A3 and 1-A4 channels is
output).

e. Press the Down arrow key to move the cursor to Channel Addition for
the 1-A4 channel.

f. Push the SELECT button to display the pop-up menu. You can select
Normal or AND. This is because the XOR channel composition is not
allowed with any even numbered channel. Select AND, then press the
ENTER key. The ANDed signal of the 1-A4 and 1-A3 channels is
output from the 1-A4 channel.

g. Using the arrow keys, move the cursor to Polarity for the 1-A1 channel.

h. The Polarity specifies the deflection polarity of the output signal by two
parameters of Normal and Invert.

To select a parameter you must select from two options, you can press either
the SPACE or ENTER key, in addition to using the SELECT orMENU

button to select from the menu.

5. Push the RUN button to stop signal output.

6. Push the ALL OUTPUTS ON/OFF button to turn off the output switches
for all the channels.
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To complete the Tutorial 1, you must perform one more procedure.

1. If you want to exit the tutorial now, push theMENU button, select Exit
from the File menu, and then press the ENTER key. If you want to go to
Tutorial 2 immediately, push the PULSE GEN button to enter the Data
Generator mode.

2. When you have made changes to the original settings from the start of the
Pulse Generator mode, a confirmation dialog box is displayed. Using the
TAB key, select either the Yes or No, and then press the ENTER key. In this
tutorial, select Yes.

3. The Save Setup dialog box appears. Since it is identical to the Windows file
save dialog box, you can use this dialog box with the same way as a
Windows PC. In this example, you save the file from the front panel of the
data timing generator.

a. Press the TAB key to activate the file view. The content of the folder
specified in the Save in: box is displayed in the file view.

b. Select the file or folder using the Up and/or Down arrow keys. Refer to
File Operations on page 2--45.

� Select the file or folder in the file view area, then press the BKSP key to
move into the higher folder.

� Select the file or folder in the file view area, then press the ENTER key
to open the file or folder.

c. Repeat the same steps to reach the target folder.

4. Press the TAB key to activate File name: input box. Enter the file name
following the steps below:

a. Pressing the front panel ALPHA key makes the key LED light up to
indicate the ALPHA input (character input) mode is activated.

b. For details of text input, refer to Text Input on page 2--45.

In the ALPHA input mode, by pressing the numeric key, you can input
characters labeled on the key. In this tutorial, you name the file tutorial1.

c. Press 2 once to select t, then press the Right arrow key to enter t.

Saving a Setup File
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d. Press 2 twice to select u, then press the Right arrow key to enter u.

e. Press 2 once to select t.

f. Press 6 once. The t is entered, and m is automatically selected at the
right. Press 6 twice to select o.

g. Press 1 three times. The o is entered and r is selected.

h. Press 4 three times. The r is entered and i is selected.

i. Press 8 once. The i is entered and a is selected.

j. Press 5 three times. The a is entered and l is selected.

k. Press 1 nine times to enter 1. Digit 1 is selected.

l. Press the ENTER key to enter 1. Input of tutorial1 is complete.

m. The extension is assigned automatically. Press the ENTER key again.
The settings file is saved under the name of tutorial1.dtg.

The DTG5000 Series data timing generator settings file contains all the output
information such as the parameters, pattern data, grouping and channel assign-
ment you have set in the windows in the Pulse Generator and/or Data Generator
mode. You can restore the settings by loading the settings file using the Open
Setup pull-down menu. This ends the Tutorial 1.
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Tutorial 2: Data Generator Mode

To output a pattern in the Data Generator mode, you must perform the following
steps.

� Grouping and channel assignment

� Creating a block

� Creating a pattern data

� Setting the output parameters

1. Do the following steps to restore the default settings.

a. Select theMENU button, select Default Setup from the File menu by
using the arrow keys, and then press the ENTER key.

b. If the PULSE GEN button stays lit, this indicates that the data timing
generator is not yet in the Data Generator mode. In this case, push the
PULSE GEN button to enter the Data Generator mode.

A block is a container for the pattern data to be output. Do the following steps to
create a block.

1. Push theMENU button, select Settings using the arrow keys, select Blocks
using the arrow keys, and then press the ENTER key to open the Blocks
window.

Figure 4--6: Blocks window

Default Setup

Creating a Block
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By default, you have a block with the block size, or the vector length, of 1000
under the name of Block1. Use the default block in this tutorial.

This window allows you to resize blocks and create new blocks.

� You can define up to 8,000 blocks. Each of the blocks has a name of up to 32
characters. To define the block name, first select the character input mode by
pressing the ALPHA key.

� You can set the block size from 1 to 8,000,000 for the DTG5078, or 1 to
32,000,000 for the DTG5274. The data timing generator is sometimes unable
to output the pattern data due to the minimum block length or the block size
granularity, depending on the operating condition.

Using the Channel Group window, grouping and channel assignment can be
performed. Grouping is to collect the logical channels on the pattern data into a
group. Channel assignment is to assign the logical channels on the pattern data to
the physical channels on the output module.

If you have defined more than one block, the grouping and channel assignments
are common to the system. For details about the data structure, refer to Blocks on
page 3--3.

1. Push theMENU button, select Settings, select Channel Group using the
arrow keys, and then press the ENTER key to open the Channel Group
window.

Figure 4--7: Channel Group window

Grouping and Channel
Assignment
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Group List. The default group names appear in the Group List represent the
maximum number of logical channels which can be used with the mainframe.
The logical channels are grouped by eight channels per one group.

The Group lists the grouped logical channels.

The CH lists the physical channels assigned to the logical channels, in the format
of “mainframe number - slot name and channel number”, such as 1-A1.

The installed physical channels are displayed in the right window pane of display
area. Any channel indicated by a bullet in a white rectangle has already been
assigned to a logical channel.

The logical channels can be created up to 32 channels for the DTG5078, and 8
channels for the DTG5274, and they are independent of the installed output
modules.

Now, proceed to grouping and channel assignment.

2. Press the TAB key repeatedly. Group List and Channels are activated
alternately. Activate the Group List.

3. In the Group List, you can move the cursor using the arrow keys. Move the
cursor to the Group column.

4. Resize Group1.

a. Push the SELECT button, select Rename/Resize Group... from the
pop-up menu using the arrow keys, and then push the SELECT button.

b. The Grouping dialog box appears.

c. Press the TAB key to move the cursor to Bits, use the numeric key to
enter 4, and then press the ENTER key. The Group1 size changes to 4.

5. Create a group named Group2 that has four logical channels (Bits).

a. Push the SELECT button, select New Group... using the arrow keys,
and then push the SELECT button.

b. The Grouping dialog box appears.
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c. To enter the group name, press the ALPHA key to enter the character
input mode.

d. Press the numeric key 4 four times to enter G, press 1 three times to
enter r, press 6 three times to enter o, press 2 twice to enter u, and then
press 1 once to enter p.

e. Press the ALPHA key to exit the character input mode.

f. Press the numeric key 2 to enter 2. Input of Group2 is complete.

g. Press the TAB key to activate Bits.

h. Press the numeric key 4, and then press the ENTER key. The Grouping
dialog box disappears. A new Group2 of four channels is created.

6. Assign the Slot A physical channels to Group2.

a. Using the arrow keys, move the cursor to Group2:03. Press the TAB
key to activate Channels.

b. Move the cursor to Slot A Channel 1 using arrow keys.

c. Press the ENTER key. A white circle is added to the Channel 1 box. In
the Group List at the left, physical channel 1-A1 is displayed at CH of
Group2:03, and the cursor automatically moved to Group2:02.

d. Press the Right arrow key to move the cursor to Channel 2. Press the
ENTER key. Slot A Channel 2 is assigned to Group2:02.

e. Assign Channels 3 and 4 of Slot A to Group2:01 and Group2:00,
respectively, in the same way.

7. Execute grouping.

For details on grouping, refer to Grouping and Channel Assignment on page
3--5.

a. Activate the Group List using the TAB key.

b. Push the SELECT button, and then select the groupings under Preset
using the arrow keys. Confirm what type of grouping options are
provided in the Preset menu.

c. Select 8 Channels per Group. A confirmation dialog box appears.
Select OK, and then proceed to the next step.

8. Delete the unnecessary groups.

a. Move the cursor to Group4 in the Group list.

b. Push the SELECT button, select Delete Group using the Up and/or
Down arrow key, and then push the SELECT button.



Tutorials

4--18 DTG5078 & DTG5274 Data Timing Generator User Manual

c. A dialog box appears to prompt you for confirmation. Select OK, and
then press the ENTER key.

d. Delete Group3 in the same way.

9. Resize Group1 and Group2.

a. Push the SELECT button, select Rename/Resize Group using the Up
and/or Down arrow keys, and then push the SELECT button.

b. The Grouping dialog box appears.

c. Press the TAB key to move the cursor to Bits, press the numeric key 4.
Then press the ENTER key. The Group2 size changes to 4.

d. Using the Up arrow key, move the cursor to Group1. Change the Group1
size to 4 in the same way.

10. The Auto Assign function is provided to perform the channel assignment
quickly.

a. Push the SELECT button, select Auto Assign using the Up and/or
Down arrow keys, and then push the SELECT button.

b. A confirmation dialog appears. Select OK. The physical channels are
assigned in order, beginning with the top logical channel in the Group
List.

This ends grouping and channel assignment.

Next, create and edit a pattern data. Creating and editing a pattern data is to
define the values included in a block. To edit the data, you can use the Data-List-
ing and/or Data-Waveform window. The two windows process the same data for
the target block and the same results are produced. The differences between the
two windows are data display format and edit method. The Data-Listing window
is mainly used in this tutorial.

1. Push the front panel DATA button. Alternatively, push theMENU button,
and select Data-Listing from the Settings menu. The Data-Listing window
appears. Pushing the DATA button repeatedly toggles between the Data-List-
ing and Data-Waveform windows alternately.

Creating a Pattern Data
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Figure 4--8: Data-Listing window

Edit the pattern data using the cursor and two markers.

2. Push theMENU button, select Edit using the arrow keys. This opens the
Edit menu, which contains edit commands.

3. Open the View menu using the Right arrow key.

Edit menu View menu

Figure 4--9: Edit menu and View menu
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The cursor is used to specify the focused cell. You can use the marker to define
the range to be edited.

To move the cursor, you can use the arrow keys, the knob, or theMove Cursor

To... command in the Edit menu. To move to a cell considerably apart from the
current position, you can quickly move using the menu. In the menu, you can
define the marker position or any vector position.

1. Push the SELECT button to open the menu.

2. Select Move Cursor To... using the Down arrow key, and then push the
SELECT button.

3. Select the Vector numeric box using the arrow keys and the TAB key, then
enter the numeric value.

4. Press the ENTER key to move the cursor to the vector position you defined.

While holding down the SHIFT key, you can define a rectangular area by
pressing the arrow keys. You are not allowed to define a rectangular area over
two or more groups.

To move a marker, you can useMove Marker To... in the Edit menu.

5. Push the SELECT button, select Move Marker To..., and then push the
SELECT button.

6. Select either the Marker1 or Marker2 numeric box using the TAB key and
arrow keys, then enter a numeric value. By setting the delta value, you can
define the position of Marker2 relative to Marker1. Press the ENTER key to
move the Maker to the vector position you defined.

Using the Cursor and
Marker
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7. If you select Cursor Pos and press the ENTER key, the values of cursor
position are input to the numeric box.

8. Use the TAB key to activate the OK button, and then press the ENTER key.
The marker moves to the cursor position.

Both the Data-Listing and Data-Waveform windows allow you to select a view
of data by the channel or by the group.

View by Channel

View by Group

Radix

Figure 4--10: View by Channel and View by Group

1. Push theMENU button, then open the View menu using the arrow keys.

2. If you select View by Channel, the data is listed by the channel. If you
select View by Group, the data is listed by the group.

Viewing a Data
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In addition, in the Data-Listing and Data-Waveform windows, you can select
Radix for the data view for one vector by group when the data is shown by
the group.

3. Push theMENU button, select Properties... from the View menu, and then
push the SELECT button.

4. Activate Radix using the TAB key. Select Radix using the arrow keys. If you
select the Signed check box when displaying the Decimal view, you can
specify the MSB bit to be used for the sign bit.

5. If you select theMagnitude check box, the data view by the group will be
magnified in the bitwise direction in the Data-Waveform window.

The edit commands are listed in the Edit menu, which you can open using either
theMENU or SELECT button.

Edit Range. For all the commands except Paste, you need to define the rectangu-
lar area to be edited.

Specify one of the following for the bitwise direction:

� Only a channel indicated by the cursor (Channel)

� A Group indicated by cursor (Group)

� Consecutive channels specified with the cursor (Selected)

Specify one of the following for the vector direction:

� All the channels in the vector direction (All)

� Channels between two markers (Between Markers)

� Channels between consecutive vectors specified with the cursor (Selected)

To specify the area, use the radio buttons located in Range and By in the dialog
box associated with the selected command. If you have specified View by Group,
the bitwise direction is fixed to Group (group indicated by the cursor).

Edit Commands
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Create the pattern data by using the edit commands.

1. Push the front panel DATA button to open the Data-Listing window.

2. Do the following unless you already have entered the View by Channel
mode:

a. Push theMENU button, then open the View menu using the arrow keys.

b. Select View by Channel, then push the SELECT button to enter the
View by Channel mode.

3. If there is 1 in the data, do the following to make all the data 0 (zero). If
there is no data 1, proceed to step 4.

a. Move the cursor to any position in Group1.

b. Push the SELECT button, select Fill with One/Zero... using the Up
and/or Down arrow keys, and then push the SELECT button to display
the Fill with One/Zero dialog box.

c. Move the focus to Range using the TAB key, and select All.

d. Move the focus to By using the TAB key, and select Group.

e. Move the focus to Filled with ... using the TAB key, and select Zero.

f. Push the SELECT button or ENTER key. All data in Group1 is
changed to 0.

Edit Operations
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g. Move the cursor to any position in Group2. Repeat the same steps from
3-b through 3-f to clear all data in Group2 to 0 in the same way.

4. Enter a value in the cell. If you are not in the View by Group mode, or Radix
is not Hex, do the following:

a. Push theMENU button, select View by Group from the View menu,
and then push the SELECT button. The data is listed by the group.

b. Push theMENU button, select Properties... from the View menu, and
then push the SELECT button. The Properties dialog box appears.

c. Select the Hex of Radix using the TAB key and arrow keys. Push the
SELECT button.

5. Move the cursor to Vector 1 in Group1. Press the numeric key 1.

6. Press the Down arrow key. Press the numeric key 2 to enter 2 in Vector 2.

7. In the same way, enter values 3 to 9 in Vector 3 to Vector 9 in order by using
the Down arrow and numeric keys.

8. Move the cursor to Vector 10.

9. If Radix is Hex, you can enter characters A to F by using keys such as ., --,
and k/m, regardless of whether you press the SHIFT key. Press the numeric
key . and then press the Down arrow key to enter A.

10. Press the numeric key --, then press the Down arrow key to enter B.

11. In the same way, enter C to F in Vector 12 to Vector 15 in order using the
unit keys.
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12. Review the values you have just entered in the Data-Waveform window.

a. Push the DATA button to open the Data-Waveform window.

b. Push theMENU button, select Properties... from the View menu, and
then push the SELECT button. The Properties dialog box appears.

c. Activate Magnitude using the TAB key. Add the check mark to
Magnitude using the SPACE key.

d. Push the SELECT button to display the up counter value you entered.

Magnified viewNormal view

13. Push the DATA button to return to the Data-Listing window.

14. Next define the range using markers.

a. Push the SELECT button, select Move Marker To..., and then push the
SELECT button. The Move Marker To dialog box appears.

b. Activate Marker2 using the TAB key, and enter 31 using numeric keys.

c. Activate Marker1 using the TAB key, and enter 16 using numeric keys.

d. Use the TAB key to activate the OK button, then press the ENTER key.

e. Marker1 is now set in the Vector 16 position, and Marker2 in the Vector
31 position.

15. Set the down counter value between the markers.

a. Push the SELECT button, select Predefined Pattern... , and then push
the SELECT button. The Predefined Pattern dialog box appears.

b. Activate Range using the TAB key.

c. Select Between Markers using the arrow keys.

d. Activate Pattern using the TAB key, then select Binary Counter.

e. Activate Direction using the TAB key, then select Down.
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f. Use the TAB key to activate the OK button, then press the ENTER key.

16. Create the same pattern in the remaining part by Copy and Paste functions.

a. Move the cursor to Vector 0 using the Up arrow key.

b. While holding down the SHIFT key, press the Down arrow key to move
the cursor to Vector 31. Hold down the SHIFT key, shifts the cursor to
define an area.

c. Select Copy... using the SELECT button. The Copy dialog box appears.

d. If you have defined an area using the cursor, Selected is specified for
Range.

e. Confirm that the OK button is active, and press the ENTER key.

f. Move the cursor to Vector 32 using the Down arrow key.

g. Push the SELECT button, and then select Paste using the arrow keys.

h. Once you push the SELECT button, the data is pasted immediately.

The Paste function only pastes the content of the paste buffer from the cursor
position. To duplicate the same pattern repeatedly in the remaining part, you
have to repeat paste operations. However, you can duplicate such patterns more
easily by using the User Defined Pattern.

17. Push the SELECT button, select User Defined Pattern... , and then push the
SELECT button. The User Defined Pattern dialog box appears.

a. Activate Range using the TAB key.

b. Select All using the arrow keys (already selected by default).

c. Move the cursor to Data using the TAB key.

d. To enter 0 to 9 from Data1 to Data10.

e. For Data11 to Data16, enter A to F.

f. For Data17 to Data32, enter F to 0.

g. Press the TAB key to activate OK, then press the ENTER key.

18. Create data for Group2.

a. Move the cursor to any of the Group2 vectors.

b. Push the SELECT button, select Clock Pattern... , and then push the
SELECT button. The Clock Pattern dialog box appears.

c. Press the ENTER key.
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The data creation for Group1 and Group2 has been completed. Before proceed-
ing to the next step, save the data you have just created.

19. Push theMENU button, select Save Setup As... from the File menu, and
then press the ENTER key.

20. The Save Setup dialog box appears. You can save the setup file using this
dialog box. Save the setup file under the name of Tutorial2. See Saving a
Setup File on page 4--12.

This completes the pattern data creation.

Use the pattern data you have just created for setting the output parameters such
as level, clock frequency or pulse width.

Performing Signal Output. To set the output level in the Level window, you can
use the same procedure as the Pulse Generator mode.

To output the pattern in the Data Generator mode, do the following steps:

1. Push the LEVEL button to open the Level window. You can operate the
Level window in the same way as the Pulse Generator mode.

2. Verify that the High and Low levels are 1.000 V and 0.000 V, respectively.
Push the ALL OUTPUTS ON/OFF button to turn on the output of all the
channels.

3. Push the RUN button. The data is loaded into the pattern memory, and then
the output begins.

Setting up Output
Parameters
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You need to familiarize the specific settings of the Timing window in the Data
Generator mode.

Figure 4--11: Timing window

Changing a Clock Frequency. Do the following to change the clock frequency:

1. Push the TIMING button to open the Timing window.

2. Activate the Clock Frequency using the TAB key.

3. Use the knob and the Digit Select keys to change the Clock Frequency
setting to 750.00000 MHz.

4. Press the TAB key to activate the channel table.

Changing a Format. Do the following to change the format:

1. Use the arrow keys to move the cursor to Format for Group2:03 channel.

2. Push the SELECT button, select RZ from the View menu, and then push
the SELECT button.

If you set the Format to RZ or R1, you can set Pulse Width, Duty, and Cross
Point. The Cross Point Adjustment is available only in the following condition.

� The DTGM30 output module is used.

� The output module is installed in slot A, B, C or D.

� The Format is set to NRZ.

Timing Window
Operations
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If RZ or R1 is specified in any of the channel Format, the maximum Clock
Frequency is restricted to 1.675 GHz for the DTG5274 and 375 MHz for the
DTG5078. These values are half of the NRZ Format.

3. Push the SELECT button, select Apply to Channels in the Same Group,
and then push the SELECT button.

You can specify the single Format to all the channels within the same group
by using the Apply to Channels in the Same Group command.

Changing a Pulse Width. To change the pulse width, do the following steps.

1. Using the arrow keys, move the cursor to the PW/Duty/Cross Point for
Group2:03. The D 50.0% is displayed in the column. This indicates that the
pulse width is set and displayed with Duty.

2. Change the value to 75.0% using the knob.

3. Move the cursor to the PW/Duty/Cross Point for Group2:02 using the
Down arrow key.

4. Select Pulse Width using the SELECT button and the arrow keys, and then
push the SELECT button. This channel has been set and the pulse width is
displayed in the Pulse Width box.

5. Move the cursor to the PW/Duty/Cross Point for Group2:01 using Down
arrow key. Select Trail Delay using the SELECT button and the keys, and
then push the SELECT button. This channel has been set and the pulse
width is displayed with the timing at the falling edge.

6. Set the value to 0.002500 �s using the knob.

Changing Delay. To change the Delay, do the following steps:

1. Move the cursor to Delay for Group2:00 using the arrow keys.

2. Use the knob and the Digit Select keys to set Lead Delay to 5.000 ns. You
can change it between 0 ns and 5.000 ns range.

3. Activate Delay Offset using the TAB key.

4. Change the Delay Offset value by turning the knob between 0 ns and 5.000
ns range. Change the Delay Offset value to 2.500 ns.

Once the Delay Offset changes, the Delay value of Group2:00 also changes
correspondingly. If you do not use the Long Delay function, the total amount of
Delay is 5.000 ns.

5. Activate the Delay for Group2:00 using the TAB key. You can change the
Delay value with the knob.



Tutorials

4--30 DTG5078 & DTG5274 Data Timing Generator User Manual

Since you have set the Delay Offset to 2.5 ns, you can change the Delay for the
Group2:00 in the --2.500 ns to 2.500 ns range. For any of the other channels, you
can set the amount of Delay within this range. Setting the Delay Offset allows
you to set a negative amount of Delay for each channel.

Activates Long Delay. If the Delay Mode is set to normal, you can set the total
amount of Delay up to 5.000 ns. To set larger amount of Delay, use the Long
Delay function.

1. Activate the Long Delay using the TAB key, then press the SPACE key to
select the check box.

2. Activate the Delay for Group2:00 using the TAB key.

3. Change the Delay value using the knob.

Activating the Long Delay function allows you to set a larger amount of Delay.
If Clock Frequency is set to 100 MHz, you can set the Delay up to 480.000 ns.

4. Using the TAB and SPACE keys, turn the Long Delay check box off.

Using the Channel Addition Function. The channel addition function allows you to
output the result of logical operation between the signals of adjacent physical
channels. For odd numbered channels, this function obtains the result of XOR
with the signal of the adjacent even numbered channel. For even numbered
channels, this function obtains the result of AND with the signal of the adjacent
odd numbered channel. You can use this function for the output modules
installed in slot A through D.

1. Use the arrow keys to move the cursor to Channel Addition for Group1:01.

2. Push the SELECT button to open the pop-up menu. You can select either
Normal or XOR because an odd numbered channel (A3Ch) has been
assigned to the physical channel. Select XOR, then push the SELECT
button.

3. Move the cursor to Channel Addition for Group1:00.

4. Push the SELECT button to open the menu. You can select either Normal
or AND because an even numbered channel (A4ch) has been assigned to the
physical channel. Select AND, then push the SELECT button.

The A3Ch outputs the pattern obtained by XORing the Group1:01 and
Group1:00 channels. The A4Ch outputs the pattern obtained by ANDing the
Group1:01 and Group1:00 channels.

5. Move the cursor to the cell where Channel Addition has been set to
Normal, and then push the SELECT button.

6. Select Apply to All Channel, and then push the SELECT button. The
settings for all the channels return to Normal.
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7. Push the RUN button to stop the output. Push the ALL OUTPUTS

ON/OFF button to turn off the Output switch.

This ends Tutorial 2.

Tutorial 3: Creating a Sequence

The sequence operation is a function that outputs a complicated pattern by
combining the block sequence, the number of repetitions, a jump, Goto, and so
on with several blocks and subsequences. In this tutorial, you create several sets
of block data and subsequences to create a sequence by combining them.

In Tutorial 3, you create the following sequence, which uses the data timing
generator sequence function.

Before starting this tutorial, initialize the data timing generator. Push theMENU

button, use the arrow keys to select Default Setup from the File menu, and then
press the ENTER key.

In this tutorial, use the predefined patterns to create the block patterns.

1. Push theMENU button, use the arrow keys to select Blocks from the
Settings menu, and then press the ENTER key.

2. The Blocks window appears.

3. The Blocks window contains a predefined block whose name is Block1. The
block size is 1000 by default. Follow the steps below to rename Block1:

a. With the cursor placed in Block1, press the ALPHA key.

b. Enter BinaryUp, and press the ENTER key twice.

c. Use the Down arrow key to move the cursor down one line.

d. Press the ALPHA key to enter the character input mode, and then enter
BinaryDown.

Creating a Block Data
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e. In the same way, define the blocks named Johnson, Graycode,
WalkingOnes,WalkingZeros, and CheckerBoard , respectively.

4. Push the front panel DATA button to open the Data-Listing window.

a. Confirm that the BinaryUp is displayed in the BlockName:.

Confirm that
the BinaryUp
is displayed

b. If the BinaryUp is not displayed, another block has been selected. If so,
push the SELECT button, use the arrow keys to select Select Block...,
and then push the SELECT button.

c. Select BinaryUp using the arrow keys in the Select Block dialog box,
and then press the ENTER key.

5. Push the SELECT button, select Predefined Pattern... using the arrow
keys, and then press the ENTER key.

6. The Predefined Pattern dialog box appears. Use the TAB key and the arrow
keys to select All for Range, Group for By, Binary Counter for Pattern,
and Up for Direction.
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7. Press the ENTER key to create the binary up counter pattern.

8. Push the SELECT button, select Select Block..., and then push the
SELECT button.

9. Select BinaryDown using the arrow keys in the Select Block dialog box,
and then press the ENTER key.

10. Push the SELECT button, select Predefined Pattern.. , and then press the
ENTER key.

11. The Predefined Pattern dialog box appears. Use the TAB key and the arrow
keys to select Down for Direction.

12. Press the ENTER key to create the binary down counter pattern.

13. In the same way, create the patterns in the Johnson, Graycode,Walking

Ones,WalkingZeros, and CheckerBoard blocks under the same names as
the predefined patterns.

Next, create the subsequences using the blocks you have created. The subse-
quences are recalled from the main sequence. Define the two subsequences
named SubBinary and SubWalking. See Figure 4--12.

Figure 4--12: SubBinary and SubWalking subsequences

The SubBinary operates as follows:

� Line 1. Outputs block BinaryUp 10 times before proceeding to the next line.

� Line 2. Outputs block BinaryDown 10 times before exiting this subsequence.

Creating a Subsequence
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The SubWalking operates as follows:

� Line 1. Outputs block WalkingOnes 10 times before proceeding to the next
line.

� Line 2. Outputs block WalkingZeros 10 times before exiting this subse-
quence.

1. Push theMENU button, select Subsequence from the Settings menu, and
then push the SELECT button.

2. On the first line of subsequence, enter SubBinary as the subsequence name.
To input the characters, press the ALPHA key to change the character input
mode.

3. Activate the table at the right using the TAB key. Use this table to define the
content of SubBinary.

4. With the cursor placed on the first line in Block1, push the SELECT button.
The predefined block name list is displayed under the menu items, select
BinaryUp, and then push the SELECT button.

5. Move the cursor to Repeat using the arrow keys, use the numeric key to
enter 10 for the number of repetition, and then press the ENTER key.

6. On the second line in Block, set BinaryDown for the block name and 10 for
the Repeat count.

7. Move the cursor to the second line in Sub-sequence using the TAB key and
arrow key.

8. Enter SubWalking as the subsequence name.

9. Activate the table at the right using the TAB key, and then move the cursor
to the first line in Block using the arrow keys.

10. Repeat the same steps as SubBinary to set theWalkingOnes for Block name
and 10 for repeat count on the first line,WalkingZeros for Block name and
10 for repeat count on the second line.
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Next, create the main sequence as summarized in Table 4--1. The subsequences
allow you to set only the number of repetitions of the block. The main sequence
allows you to set the number of repetitions, the trigger queue, and jumps. This
sequence operates as follows:

� Line 1. Waits for a trigger event. After the event occurs, the system outputs
the block BinaryUp 400 times, and then proceeds to the next line.

� Line 2. Repeats the block Johnson 600 times, and proceeds to the next line.
If an event occurs during the output, a jump occurs to the line labeled
Graycode.

� Line 3. Repeats the subsequence SubBinary infinitely. If an event occurs
during the output, a jump occurs to the line labeled Start.

� Line 4. Repeats the block Graycode 400 times, and proceeds to the next
line. If an event occurs during the output, a jump occurs to the line labeled
End.

� Line 5. Repeats the subsequence SubWalking 600 times, and jumps to the
line labeled Graycode. If an event occurs during the output, a jump occurs
to the line labeled End.

� Line 6. Repeats the block Checkerboard 200 times, and exits the sequence.

Table 4--1: Main sequence

Line Label
Wait
Trig.

Blocks/
Sub-sequence Repeat

Event Jump
To Go To

1 Start On BinaryUp 400

2 Johnson 600 Graycode

3 SubBinary Inf. Start

4 Graycode Graycode 400 End

5 SubWalking 600 End Graycode

6 End CheckerBoard 200

To create the main sequence, do the following steps:

1. Push theMENU button, select Sequence from the Settings menu, and then
push the SELECT button.

2. Move the cursor to Label of Line 1, press the ALPHA key to enter the
character input mode. Enter Start to the Label cell of Line1, and then press
the ENTER key twice.

Creating a Main Sequence
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3. Use the Right arrow key to move the cursor toWaitTrig. Press the SPACE
key to enter On.

4. Use the Right arrow key to move the cursor to Block/Sub-sequence , push
the SELECT button, select BinaryUp from the pop-up menu, and then push
the SELECT button. The block name BinaryUp is entered.

5. Use the Right arrow key to move the cursor to Repeat. Enter 400 using
numeric keys.

6. Use the arrow keys to move the cursor to Block/Sub-sequence on Line 2.

7. By repeating the same steps as described above, enter the sequence
parameters from the second through sixth lines listed in Table 4--1. To enter
Inf. (Infinitive repeat count), push the SELECT button and then select
Infinite from the pop-up menu.

8. For Sequencer Mode, Jump Mode, and Jump Timing, use the default
settings. Make sure that Sequencer Mode is set to Hardware, Jump Mode is
set to Event, and Jump Timing is set to Async.

Confirm that
the Hardware
is selected

Confirm that
the Event is
selected

Confirm that
the Async is
selected

Figure 4--13: Main sequence
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In this tutorial, you have created a sequence by combining several blocks and
subsequences. The flow of created sequence is shown in Figure 4--14.

Checkerboard
x 200

Wait for
trigger

End

Johnson
x 600

Event

BinaryUp
x 400

Start

SubBinary
Infinite

Graycode
x 400

SubWalking
x 600

Event

Event

Event

GoTo

Figure 4--14: Flowchart

The pattern data you output in Tutorial 2 is also a sequence that outputs a single
block infinitely. The output sequence is therefore the same as usual pattern
output.

In this section, you use theMANUAL TRIGGER andMANUAL EVENT

buttons on the front panel to generate a trigger and an event.

For grouping and channel assignment, use the default settings. For the Level
window settings, also use the default settings.

Executing a Sequence
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Do the following steps to output the sequence you created:

1. Push the ALL OUTPUTS ON/OFF button to turn on the relay of the output
channel.

2. Push the RUN button. The sequence is loaded and the data is checked. After
verifying that the data contains no error, the output begins.

3. TheWait Trigger is activated on the first line in the loaded sequence. The
output does not begin until an trigger occurs. TheWaiting appears in the
status display field. Once you push theMANUAL TRIGGER button, the
signal output begins.

4. Wait. The SubBinary (third line) will be output repeatedly. If you push the
MANUAL EVENT button during the output, the output process jumps to
the first line.

5. The sequence is waiting for a trigger. Push theMANUAL TRIGGER

button to start the output.

6. While the block Johnson (second line) is being output, push theMANUAL

EVENT button to jump to the fourth line.

7. The sequence repeats the output of the fourth and fifth lines.

8. While this loop is repeated, if you push theMANUAL EVENT button, the
output process jumps to the End line, then the block CheckerBoard is
output, and finally exits the sequence. A message Stopped is displayed in
the status display field.

9. If you want to stop the output while the output is being performed, push the
RUN button. If the RUN button LED is not lit, this indicates that the output
is off.

10. Once the output finishes, push the ALL OUTPUTS ON/OFF button to turn
off the relay of the output connector.

This completes Tutorial 3.
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Index

Numbers
10 MHz REF OUT, 2--10

A
Accessories, 1--17
optional, 1--20
standard, 1--19

Activates Long Delay, Timing window, 4--30
Address, Tektronix, ix
ALL OUTPUTS ON/OFF button, 2--4
tutorial, 4--8

ALPHA key, 2--4
text input, 2--45

ALT key, 2--4
Application Windows, 2--10
arrow keys, 4--3
Arrow keys (Up, Down, Left and Right), 2--2
Assigning a Channel, 3--5, 3--9
Auto Assign function, 3--9
tutorial, 4--18

B
backing up user files, 1--16
BKSP key, 2--4
block, 3--3
Blocks window, 2--18
Edit Menu, 2--19
tutorial, 4--14

C
CD--ROM drive, location, 1--9
Changing a Clock Frequency, Timing window, 4--28
Changing a Delay, Timing window, 4--29
Changing a Format, Timing window, 4--28
Changing a Pulse Width, Timing window, 4--29
Channel Addition, 4--30
Timing window, 2--27

channel assignment, 3--5, 3--9
tutorial, 4--15

Channel Group window, 2--17
define a group, 3--6
Edit menu, 2--17
tutorial, 4--15
window operation, 2--42

Channels, Channel Group window, 2--17
CLK IN, Master--Slave Connection, 2--9
CLK OUT, Master--Slave Connection, 2--9
CLOCK EXTERNAL IN, 2--8
CLOCK OUT, 2--8
Configuration
mainframe and output module, 1--3
software installation, 1--16
System, 1--5

connecting peripherals, 1--9
connecting to a network, 1--8
connectors, front panel, 2--5
Contacting Tektronix, ix
control box menus, 2--11
creating, emergency rescue disk, 1--14
Creating a Block, tutorial, 4--14
Creating a Block Data, tutorial, 4--31
Creating a Main Sequence, tutorial, 4--35
Creating a New Group, 3--7
Creating a Pattern Data, 4--18
Creating a Sequence, tutorial, 4--31
Creating a Subsequence, tutorial, 4--33
CTRL key, 2--4
cursor, 4--20

D
DATA button, 2--3
Data Generator Mode, tutorial, 4--14
Data--Listing window, 2--20
Edit Menu, 2--21
tutorial, 4--19
window operation, 2--40

Data--Waveform window, 2--22
Edit Menu, 2--22

DC OUTPUT, front panel connector, 2--6
DC Output window, 2--35
De--assigning a Channel, 3--10
Default Setup, File menu, 2--11
Defining a Group, 3--5
DEL key, 2--4
Deleting a Group, 3--8
Description
key features, 1--1
Product, 1--1

Digit Select arrow keys, 2--3, 4--3
Display Area, 2--10
DTG5000 Configuration Utility, 1--4
DTG5000 Software, 1--3
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E
Edit menus
Blocks window, 2--19
Channel Group window, 2--17
Data--Listing window, 2--21, 2--22
DC Output window, 2--36
Level window, 2--25
Sequence window, 2--31
Subsequence window, 2--33
Timing window, 2--27

Edit Operations, 4--23
End Program dialog, 1--13
environment requirements, 1--6
ESC key, 2--2
EVENT IN, front pane connector, 2--6
Executing a Sequence, tutorial, 4--37
EXTERNAL 10 MHz REF IN, 2--10
external monitor, 1--9

F
File Menu, 2--11
File Operations, 2--45
front panel connectors, 2--5
front panel controls, 2--1
System menu, 2--14

G
group, 3--3
Group List, Channel Group window, 2--17, 3--6, 4--16
grouping
data structure, 3--5
tutorial, 4--15

H
Help Menu, 2--14

I
Installation, 1--5–1--16
software installation, 1--16

installing output module, 1--7
instrument problems, system diagnostics, 1--16
Internal Pattern Data, 3--1
Introduction, to this manual, vii

J
Jitter Generation window, 2--34
JUMP IN, Master--Slave Connection, 2--9
JUMP OUT, Master--Slave Connection, 2--9

K
Key Operations, 2--47
keyboard, 2--48
Knob, front panel controls, 2--3

L
LAN port, 1--9, 2--8
language options, 1--18
LEVEL button, 2--3
Level window, 2--24
Edit Menu, 2--25
how to use, 4--7

logical channel, 3--2

M
Mainframe and Output Module Configuration, 1--3
MANUAL EVENT button, 2--3
MANUAL TRIGGER button, 2--3
Manuals
part numbers, 1--18
related, viii

marker, 4--20
Master--Slave Connection, 2--9
Menu Bar, 2--10, 2--11
MENU button, 2--1
menu operations, 2--37
Menu selection, 2--37
menu system, 2--37
Monitor, 1--9
mouse, 2--48
Move Cursor To..., dialog box, 4--20
Move Marker To..., dialog box, 2--41, 4--20

N
navigation keys, 2--1
ESC key, 2--2
MENU button, 2--1
SELECT button, 2--2
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TAB key, 2--2
Network, connecting, 1--8
numeric input, 2--44
using the knob, 2--44

O
Offline mode, 4--1
On/Standby switch, 1--10
operating requirements, 1--7
Optional accessories, 1--20
Options Menu, 2--14
Output a Signal, tutorial, 4--5
output module, installing, 1--7

P
peripheral, connecting, 1--9
PHASE LOCK IN, 2--9
Phone number, Tektronix, ix
physical channel, 3--2
pop--up menu, 4--6
Pop--up Menu Items, 2--37
powering off, 1--12
powering on, 1--10
Predefined Level, Edit Menu, Level window, 2--25
Predefined Level dialog box, 4--7
preset grouping options, 3--8
principal power switch, 1--10
Printer, 1--9
Product
accessories, 1--17
Description, 1--1
software, 1--3

Product support, contact information, ix
PULSE GEN button, 2--3, 4--4
Pulse Generator Mode, tutorial, 4--4

R
Readme file, 1--4
Rear Panel Connectors, 2--7
Related Manuals, viii
removing output module, 1--8
Renaming a group, 3--7
rescue disk, creating, 1--14
Resizing a group, 3--7
resolution settings, external display, 2--8
RUN button, 2--3

S
Saving a Setup File, 4--12
Screen elements, 2--10
SELECT button, 2--2
pop--up menu, 2--37

sequence, 3--3
Sequence window, 2--30
Edit Menu, 2--31
window operation, 2--43

Service support, contact information, ix
Setting up Output Parameters, 4--27
Setting up Windows 2000, 1--11
Settings Menu, 2--13
SHIFT key, 2--3
Shutting down, 1--12
site considerations, 1--6
SKEW CAL IN, front panel connector, 2--6
Software, upgrade, 1--4
Software Installation, 1--16
SPACE key, 2--4
stacking the mainframes, 1--6
Standard, accessories, 1--19
Status Bar, 2--10, 2--16
Subsequence window, 2--32
Edit menu, 2--33

Suffix buttons, 2--3
SYNC OUT, front panel connector, 2--6
system diagnostics, 1--16
System Menu, 2--13
system software, 1--3

T
TAB key, 2--2
Technical support, contact information, ix
Tektronix, contacting, ix
Text Input, 2--45
Time Base window, 2--28
PG mode, 4--4
window operation, 2--38

TIMING button, 2--3
Timing window, 2--26
Edit menu, 2--27
how to use, 4--9
tutorial, 4--28
window operation, 2--39

Toolbar, 2--10, 2--15
TRIGGER IN, front panel connector, 2--5
tutorial, Pulse Generator Mode, 4--4
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U
unpacking, 1--5
Update, Software, 1--4
Upgrade, software, 1--4
URL, Tektronix, ix
USB port
front panel, 2--6
rear panel, 1--9

user files, backing up, 1--16
using cursor, 4--20
using marker, 4--20
Using the Channel Addition Function, 4--30

V
View by Channel, 4--21
View by Group, 4--21
View Menu, 2--12

W
Web site address, Tektronix, ix
Windows 2000, set up, 1--11
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